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1. About the Manual for the Mageia Control Center
The Mageia Control Center (MCC) has eight different options or tabs to choose from in the left
column, and even ten if the drakwizard package was installed. Each of these tabs gives a different
set of tools that can be selected in the big right panel.

The ten following chapters are about those ten options and the related tools.

The last chapter is about some other Mageia tools, that cannot be chosen in any of the MCC tabs.

The titles of the pages will often be the same as the titles of the tool screens.

There is also a search bar available, which you can access by clicking on the "Search" tab in the
left column.

2. Zarządzanie oprogramowaniem

In this screen you can choose between several tools for software management. Click on a link
below to learn more.
Zarządzanie oprogramowaniem

1. Sekcja 2.1, „Software Management (Install and Remove Software)”

2. Sekcja 2.2, „Uaktualnianie pakietów oprogramowania” = Update your system
3. Sekcja 2.3, „Konfiguracja częstotliwości aktualizacji”

4. Sekcja 2.4, „Configure Media” = Configure media sources for install and update

2.1. Software Management (Install and Remove Software)
rpmdrake

2.1.1. Introduction to rpmdrake

This tool1, also known as drakrpm, is a program for installing, uninstalling and updating packages.
It is the graphical user interface of URPMI. At each start up, it will check online package lists (called
'media') downloaded straight from Mageia's official servers, and will show you each time the latest
applications and packages available for your computer. A filter system allows you to display only
certain types of packages: you may display only installed applications (by default), or only available
updates. You can also view only not installed packages. You can also search by the name of a
package, or in the summaries of descriptions or in the full descriptions of packages or in the file
names included in the packages.

To work, rpmdrake needs the repositories to be configured with Sekcja 2.4, „Configure Media” .

During the installation, the configured repository is the medium used for the installation,
generally the DVD or CD. If you keep this medium, rpmdrake will ask it each time you
want to install a package, with this pop-up window :

If the above message annoys you and you have a good internet connection without too
strict download limit, it is wise to remove that medium and replace it by online reposito-
ries thanks to Sekcja 2.4, „Configure Media” .

1You can start this tool from the command line, by typing rpmdrake as root.

1



Moreover, the online repositories are always up to date, contains much more packages,
and allow to update your installed packages.

2.1.2. The main parts of the screen

1. Package type filter:

This filter allows you to display only certain types of packages. The first time you start the
manager, it only displays applications with a graphical interface. You can display either all the
packages and all their dependencies and libraries or only package groups such as applications
only, updates only or backported packages from newer versions of Mageia.

The default filter setting is for new entrants to Linux or Mageia, who probably do
not want command line or specialist tools. Since you're reading this documentation,
you're obviously interested in improving your knowledge of Mageia, so it is best to
set this filter to "All".

2. Package state filter:

This filter allows you to view only the installed packages, only the packages that are not installed
or all of the packages, both installed and not installed.

3. Search mode:

Click on this icon to search through the package names, through their summaries, through their
complete description or through the files included in the packages.

4. "Find" box:

Enter here one or more key words. If you want to use more than one keyword for searching use
'|' between keywords, e.g. To search for "mplayer" and "xine" at the same time type 'mplayer
| xine'.

5. Erase all:

This icon can erase in one click all the key words entered in the "Find" box .

6. Categories list:

This side bar groups all applications and packages into clear categories and sub categories.

7. Description panel:

This panel displays the package's name, its summary and complete description. It displays
many useful elements about the selected package. It can also show precise details about the
package, the files included in the package as well as a list of the last changes made by the
maintainer.

2.1.3. The status column

Once you correctly set the filters, you can find your software either by category (in area 6 above) or
by name/summary/description using area 4. A list of packages fulfilling your query and, don't forget,
the chosen medium is shown with different status markers according to whether each package is
installed/not installed/an update... To change this status, just check or uncheck the box before the
package name and click on Apply.
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Ikona Legend

This package is already installed

This package will be installed

This package cannot be modified

This package is an update

This package will be uninstalled

Tabela 1.

Examples in the screenshot above:

• If I uncheck digikam (the green arrow tell us it is installed), the status icon will go red with an up
arrow and it will be uninstalled when clicking on Apply.

• If I check qdigidoc (which is not installed, see the status), the orange with a down arrow status
icon will appear and it will be installed when clicking on Apply.

2.1.4. The dependencies

Some packages need other packages called dependencies in order to work. They are for example
libraries or tools. In this case, Rpmdrake displays an information window allowing you to choose
whether to accept the selected dependencies, cancel the operation or get more information (see
above). It may also happen that various packages are able to provide the needed library, in which
case rpmdrake displays the list of alternatives with a button to get more information and another
button to choose which package to install.

2.2. Uaktualnianie pakietów oprogramowania
MageiaUpdate or drakrpm-update

This tool2 is present in the Mageia Control Center under the tab Software management.

To work, MageiaUpdate needs the repositories to be configured with drakrpm-editmedia
with some media checked as updates. If they are not, you are prompted to do so.

As soon as this tool is launched, it scans the installed packages and lists those with an update
available in the repositories. They are all selected by default to be automatically downloaded and
installed. Click on the Update button to start the process.

By clicking on a package, more information is displayed in the lower half of the window. The print
> before a title means you can click to drop down a text.

2You can start this tool from the command line, by typing MageiaUpdate or drakrpm-update as root.
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When updates are available, an applet in the system tray warns you by displaying this
red icon  . Just click and enter the user password to update the system alike.

2.3. Konfiguracja częstotliwości aktualizacji
mgaapplet-config

This tool3 is present in the Mageia Control Center under the tab Software management. It is also
available by a right click / Updates configuration on the red icon  in the system tray.

The first slider allows you to change how frequently Mageia will check for updates and the second
the delay after booting before the first check. The check box gives you the option to be warned
when a new Mageia release is out.

2.4. Configure Media
drakrpm-edit-media

First thing to do after an install is to add software sources (also known as repositories,
media, mirrors). That means you must select the media sources to be used to install
and update packages and applications. (see Add button below).

If you install (or upgrade) Mageia using an optical media (DVD or CD) or a USB device,
there will be a software source configured to the optical media used. To avoid being
asked to insert the media when you install new packages, you should disable (or delete)
this media.  (It will have the media type CD-Rom).

Your system is running under an architecture which may be 32-bit (called i586), or 64-bit
(called x86_64). Some packages are independent of whether your system is 32-bit or
64-bit; these are called noarch packages. They don't have their own noarch directories
on the mirrors, but are all in both the i586 and the x86_64 media.

This tool is present in the Mageia Control Center under the tab Software management.4

2.4.1. The columns

Column Enable:

The checked media will be used to install new packages. Be cautious with some media such as
Testing and Debug, they could make your system unusable.

Column Update:

The checked media will be used to update packages, it must be enabled. Only media with "Update"
in its name should be selected. For security reasons, this column isn't modifiable in this tool, you
must open a console as root and type drakrpm-edit-media --expert.

3You can start this tool from the command line, by typing mgaapplet-config as root.
4You can start this tool from the command line, by typing drakrpm-edit-media as root.
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Column medium:

Display the medium name. Mageia official repositories for final release versions contain at least:

• Core which contains most programs available supported by Mageia.

• Nonfree which contains some programs which are not free

• Tainted free software for which there might be patent claims in some countries.

Each medium has 4 sub-sections:

• Release the packages as of the day the this version of Mageia was released.

• Updates the packages updated since release due to security or bug concerns. Everyone should
have this medium enabled, even with a very slow internet connection.

• Backports some packages of new versions backported from Cauldron (the next version under
development).

• Testing which is used for temporary tests of new updates, to allow the bug reporters and the QA
team to validate the corrections.

2.4.2. The buttons on the right

Remove:

To remove a medium, click on it and then on this button. It is wise to remove the medium used for
the installation (CD or DVD for example) since all the packages it contains are in the official Core
release medium.

Edit:

Allows you to modify the selected medium settings, (URL, downloader and proxy).

Add:

Add the official repositories available on the Internet. These repositories contain only safe and well
tested software. Clicking on the "Add" button adds the mirrorlist to your configuration, it is designed
to make sure that you install and update from a mirror close to you. If you prefer to choose a specific
mirror, then add it by choosing "Add a specific media mirror" from the drop-down "File" menu.

Up and down arrows:

Change the list order. When Drakrpm looks for a package, it reads the list in the displayed order and
will install the first package found for the same release number - in the event of a version mismatch,
the latest release will be installed. So if possible, put the fastest repositories at the top.

2.4.3. The menu

File -> Update:

A window pops up with the media list. Select the ones you want to update and click on the Update
button.

File -> Add a specific media mirror:

Suppose you aren't happy with the actual mirror, because for example it's too slow or often una-
vailable, you can choose another mirror. Select all the actual media and click on Remove to take
them out. Click on File -> Add a specific media mirror, choose between update only or the full set
(if you do not know, choose the Full set of sources) and accept the contact by clicking on Yes. This
window opens:
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You can see, on the left, a list of countries, choose yours or one very close by clicking on the >
symbol, this will display all the available mirrors in that country. Select one and click on OK.

File -> Add a custom medium:

It is possible to install a new media (from a third party for example) that isn't supported by Mageia.
A new window appears:

Select the medium type, find a smart name that well define the medium and give the URL (or the
path, according to the medium type)

Options -> Global options:

This item allows you to choose when to "Verify RPMs to be installed" (always or never), the do-
wnload program (curl, wget or aria2) and to define the download policy for information about the
packages (on demand -by default-, update only, always or never).

Options -> Manage keys:

To guarantee a high level of security, digital keys are used to authenticate the media. It is possible
for each medium to allow or disallow a key. In the window that appear, select a medium and then
click on Add to allow a new key or to select a key and click on Remove to disallow that key.

Do this with care, as with all security-related questions

Options -> Proxy:

If you need to use a proxy server for internet access, you can configure it here. You only need to
give the Proxy hostname and if necessary a Username and Password.

For more information about configuring the media, see the Mageia Wiki page [https://wiki.mage-
ia.org/en/Software_management].

3. Udostępnianie

This screen and the one for Network Services are only visible if the drakwizard package is instal-
led. You can choose between several tools to set up different servers. Click on a link below or on
Sekcja 4, „Usługi sieciowe”to learn more.
Udostępnianie

1. Sekcja 3.1, „Konfiguracja FTP”

2. Sekcja 3.2, „Configure webserver”

3.1. Konfiguracja FTP
drakwizard proftpd

This tool5 can help you to set up an FTP server.

5You can start this tool from the command line, by typing drakwizard proftpd as root.
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3.1.1. What is FTP?

File Transfer Protocol (FTP) is a standard network protocol used to transfer files from one host to
another host over a TCP-based network, such as the Internet. (From Wikipedia)

3.1.2. Setting up an FTP server with drakwizard proftpd

Welcome to the FTP wizard. Buckle up.

1. Wprowadzenie

The first page is just an introduction, click Next.

2. Selecting Server Exposer: Local Net and/or World

Exposing the FTP server to the Internet has it's risks. Be ready for bad things.

3. Server Information

Enter name the sever will use to introduce itself, someone to email complaints too and whether
to allow root login access.

4. Server Options

Set listening port, jailed user, allow resumes and/or FXP (File eXchange Protocol)

5. Podsumowanie

Take a second to check these options, then click Next.

6. Zakończ

You're done! Click Finish.

3.2. Configure webserver
drakwizard apache2

This tool6 can help you to set up a web server.

3.2.1. What is a web server?

Web server is the software that helps to deliver web content that can be accessed through the
Internet. (From Wikipedia)

3.2.2. Setting up a web server with drakwizard apache2

Welcome to the web server wizard.

1. Wprowadzenie

The first page is just an introduction, click Next.

6You can start this tool from the command line, by typing drakwizard apache2 as root.
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2. Selecting Server Exposer: Local Net and/or World

Exposing the web server to the Internet has it's risks. Be ready for bad things.

3. Server User Module

Allows users to create their own sites.

4. User web directory name

The user needs to create and populate this directory, then the server will display it.

5. Server Document Root

Allows you to configure the path to the web servers default documents.

6. Podsumowanie

Take a second to check these options, then click Next.

7. Zakończ

You're done! Click Finish.

4. Usługi sieciowe

This screen and the one for Sharing are only visible if the drakwizard package is installed. You
can choose between several tools to set up different servers. Click on a link below or on Sekcja 3,
„Udostępnianie ”to learn more.
Usługi sieciowe

1. Sekcja 4.1, „Konfiguracja DHCP”

2. Sekcja 4.2, „Konfiguracja DNS”

3. Sekcja 4.3, „Konfiguracja pośrednika”

4. Sekcja 4.4, „Konfiguracja czasu”

5. Sekcja 4.5, „Konfiguracja serwera OpenSSH”

4.1. Konfiguracja DHCP
drakwizard dhcp

This tool is broken in Mageia 4 because of new naming scheme for the Net interfaces

This tool7 can help you to set up a DHCP server. It is a component of drakwizard which should be
installed before you can access to it.

7You can start this tool from the command line, by typing drakwizard dhcp as root.
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4.1.1. What is DHCP?

The Dynamic Host Configuration Protocol (DHCP) is a standardized networking protocol used on IP
networks that dynamically configures IP addresses and other information that is needed for Internet
communication. (From Wikipedia)

4.1.2. Setting up a DHCP server with drakwizard dhcp

Welcome to the DHCP server wizard.

1. Wprowadzenie

The first page is just an introduction, click Next.

2. Selecting Adaptor

Choose the network interface, which is connected to the subnet, and for which DHCP will assign
IP addresses, and then click Next.

3. Select IP range

Select the beginning and ending IP addresses of the range of IPs you want the server to offer,
along with the IP of the gateway machine connecting to some place outside the local network,
hopefully close to the Internet, then click Next.

4. Podsumowanie

Take a second to check these options, then click Next.

5. Hold on...

This can be fixed. Click Previous a few times and change things around.

6. Hours later...

4.1.3. What is done

• Installing the package dhcp-server if needed;

• Saving /etc/dhcpd.conf in /etc/dhcpd.conf.orig;

• Creating a new dhcpd.conf starting from /usr/share/wizards/dhcp_wizard/scripts/
dhcpd.conf.default and adding the new parameters:

– hname

– dns

– net

– ip

– mask

– rng1

– rng2

– dname

– gateway

9



– tftpserverip

– dhcpd_interface

• Also modifying Webmin configuration file /etc/webmin/dhcpd/config

• Restarting dhcpd.

4.2. Konfiguracja DNS
drakwizard bind

This page hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

You can start this tool from the command line, by typing drakwizard bind as root.

4.3. Konfiguracja pośrednika
drakwizard squid

This tool8 can help you to set up a proxy server. It is a component of drakwizard which should be
installed before you can access to it.

4.3.1. What is a proxy server?

A proxy server is a server (a computer system or an application) that acts as an intermediary for
requests from clients seeking resources from other servers. A client connects to the proxy server,
requesting some service, such as a file, connection, web page, or other resource available from
a different server and the proxy server evaluates the request as a way to simplify and control its
complexity. (From Wikipedia)

4.3.2. Setting up a proxy server with drakwizard squid

Welcome to the proxy server wizard.

1. Wprowadzenie

The first page is just an introduction, click Next.

2. Selecting the proxy port

Select the proxy port browsers will connect through, then click Next.

3. Set Memory and Disk Usage

Set memory and disk cache limits, then click Next.

4. Select Network Access Control

Set visibility to local network or world, then click Next.

5. Grant Network Access

Grant access to local networks, then click Next.

8You can start this tool from the command line, by typing drakwizard squid as root.
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6. Use Upper Level Proxy Server?

Cascade through another proxy server? If no, skip next step.

7. Upper Level Proxy URL and Port

Provide upper level proxy hostname and port, then click Next.

8. Podsumowanie

Take a second to check these options, then click Next.

9. Start during boot?

Choose if the proxy server should be started during the boot time, then click Next.

10. Zakończ

You're done! Click Finish.

4.3.3. What is done

• Installing the package squid if needed;

• Saving /etc/squid/squid.conf in /etc/squid/squid.conf.orig;

• Creating a new squid.conf starting from squid.conf.default and adding the new para-
meters:

– cache_dir

– localnet

– cache_mem

– http_port

– level 1, 2 or 3 and http_access according to level

– cache_peer

– visible_hostname

• Restarting squid.

4.4. Konfiguracja czasu
drakwizard ntp

This tool9 purpose is to set the time of your server synchronised with an external server. It isn't
installed by default and you have to also install the drakwizard and drakwizard-base packages.

4.4.1. Setup a NTP server with drakwizard ntp

1. After a welcome screen (see above), the second one ask you to choose three time servers in
the drop down lists and suggests to use pool.ntp.org twice because this server always points
to available time servers.

9You can start this tool from the command line, by typing drakwizard ntp as root.
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2. The following screens allows to choose the region and the city and then, you arrive on a sum-
mary. If something is wrong, you can obviously change it using the Previousbutton. If every-
thing is right, click on the Next button to proceed to the test. It may take a while and you finally
get this screen below:

3. Click on the Finish button to close the tool

4.4.2. What is done

This tool executes the following steps:

• Installing the package ntp if needed

• Saving the files /etc/sysconfig/clock to /etc/sysconfig/clock.orig and /etc/
ntp/step-tickers to /etc/ntp/step-tickers.orig;

• Writing a new file /etc/ntp/step-tickers with the list of servers;

• Modifying the file /etc/ntp.conf by inserting the first server name;

• Stopping and starting crond, atd and ntpd services;

• Setting the hardware clock to the current system time with UTC reference.

4.5. Konfiguracja serwera OpenSSH
drakwizard sshd

This tool10 can help you to set up an SSH daemon.

4.5.1. What is SSH?

Secure Shell (SSH) is a cryptographic network protocol for secure data communication, remote
command-line login, remote command execution, and other secure network services between two
networked computers that connects, via a secure channel over an insecure network, a server and
a client (running SSH server and SSH client programs, respectively). (From Wikipedia)

4.5.2. Setting up an SSH daemon with drakwizard sshd

Welcome to the Open SSH wizard.

1. Select Type of Configure Options

Choose Expert for all options or Newbie to skip steps 3-7, click Next.

2. Opcje ogólne

Sets visibility and root access options. Port 22 is the standard SSH port.

3. Authentication Methods

Allow a variety of authentication methods users can use while connecting, then click Next.

10You can start this tool from the command line, by typing drakwizard sshd as root.
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4. Logging

Choose logging facility and level of output, then click Next.

5. Login Options

Configure per-login settings, then click Next.

6. User Login Options

Configure the user access settings, then click Next.

7. Compression and Forwarding

Configure X11 forwarding and compression during transfer, then click Next.

8. Podsumowanie

Take a second to check these options, then click Next.

9. Zakończ

You're done! Click Finish.

5. Sprzęt

In this screen you can choose between several tools to configure your hardware. Click on a link
below to learn more.

1. Zarządzanie sprzętem

a. Sekcja 5.1, „Konfiguracja sprzętu” = Browse and configure hardware
b. Sekcja 5.2, „Konfiguracja dźwięku”

2. Konfiguracja grafiki

a. Sekcja 5.3, „Efekty pulpitu 3D” = Configure 3D Desktop effects
b. Sekcja 5.4, „Konfiguracja serwera graficznego”

3. Konfiguracja myszy i klawiatury

a. Sekcja 5.5, „Set up the Keyboard Layout”

b. Sekcja 5.6, „Konfiguracja urządzeń wskazujących (mysz, touchpad)”

4. Konfiguracja drukowania i skanowania

a. Sekcja 5.7, „Install and configure a printer” = Set up the printer(s), the print job queues, ...
b. Sekcja 5.8, „Konfiguracja skanera”

5. Inne

a. Sekcja 5.9, „Konfiguracja UPS do monitorowania napięcia”

5.1. Konfiguracja sprzętu
harddrake2
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This tool11 gives a general view of the hardware of your computer. When the tool is launched, it
executes a job to look for every element of the hardware. For that, it uses the command ldetect
which refers to a list of hardware in ldetect-lst package.

5.1.1. The window

The window is divided in two columns.

The left column contains a list of the detected hardware. The devices are grouped by categories.
Click on the > to expand the content of a category. Each device can be selected in this column.

The right column displays information about the selected device. The Help -> Fields description
gives some information about the content of the fields.

According to which type of device is selected, either one or two buttons are available at the bottom
of the right column:

• Set current driver options: this can be used to parameterize the module which is used in relation
to the device. This must used by experts only.

• Run config tool: access to the tool which can configure the device. The tool can often be accessed
directly from the MCC.

5.1.2. The menu

Opcje

The options menu gives the opportunity to check boxes to enable automatic detection:

• modem

• Jaz devices

• Zip parallel devices

By default these detections are not enabled, because they are slow. Check the appropriate box(es)
if you have this hardware connected. Detection will be operational the next time this tool is started.

5.2. Konfiguracja dźwięku
draksound

This tool12 is present in the Mageia Control Center under the tab Hardware.

Draksound deals with the sound configuration, PulseAudio options and troubleshooting. It will help
you if you experience sound problems or if you change the sound card.

PulseAudio is a sound server. It receives all the sound inputs, mixes them according to the user
preferences and sends the resulting sound to the output. See Menu ->Sound and video -> Pulse-
Audio volume control to set these preferences.

PulseAudio is the default sound server and it is recommended to leave it enabled.

11You can start this tool from the command line, by typing harddrake2 as root.
12You can start this tool from the command line, by typing draksound as root.

14



Glitch-Free improves PulseAudio with some programs. It is also recommended to leave it enabled.

The Troubleshooting button gives assistance with fixing any problems you may have. You will find
it helpful to try this before asking the community for help.

The Advanced button displays a new window with an obvious button.

5.3. Efekty pulpitu 3D
drak3d

5.3.1. Wprowadzenie

This tool13 lets you manage the 3D desktop effects on your operating system. 3D effects are turned
off by default.

5.3.2. Getting Started

To use this tool, you need to have the glxinfo package installed. If the package is not installed, you
will be prompted to do so before drak3d can start.

After starting drak3d, you will be presented with a menu window. Here you can choose either No 3D
Desktop Effects or Compiz Fusion. Compiz Fusion is part of a composite/window manager, which
includes hardware-accelerated special effects for your desktop. Choose Compiz Fusion to turn it on.

If this is your first time using this program after a clean installation of Mageia, you will get a warning
message telling you which packages need to be installed in order to use Compiz Fusion. Click on
the Ok button to continue.

Once the appropriate packages are installed, you will notice that Compiz Fusion is selected in the
drak3d menu, but you must log out and log back in for the changes to take effect.

After logging back in, Compiz Fusion will be activated. To configure Compiz Fusion, see the page
for the ccsm (CompizConfig Settings Manager) tool.

5.3.3. Wyszukiwanie problemów

5.3.3.1. Can't See Desktop after Logging in

If after turning on Compiz Fusion you attempt to log back into your desktop but can't see anything,
restart your computer to get back to the log in screen. Once there, click on the Desktop icon and
select drak3d.

When you log in, if your account is listed as an administrator, you will be prompted for your password
again. Otherwise, use the administrator login with his/her account. Then you can undo any changes
that may have caused the log in problem.

5.4. Konfiguracja serwera graficznego
XFdrake

13You can start this tool from the command line, by typing drak3d as root.
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This tool is present in the Mageia Control Center under the tab Hardware. Select Set up the gra-
phical server. 14

The buttons allow you to change the graphical configuration.

Graphic card:

The graphic card currently detected is displayed and the matching server configured. Click on this
button to change to another server, for example one with a proprietary driver.

The available servers are sorted under Vendor by manufacturer in alphabetical order and then by
model also in alphabetical order. The free drivers are sorted by alphabetical order under Xorg.

In case of problems, Xorg - Vesa will work with most graphic cards and give you time
to find and install the right driver while in your Desktop Environment.

If even Vesa doesn't work, choose Xorg - fbdev, which is used while installing Mageia,
but doesn't allow you to change resolution or refresh rates.

If you made your choice for a free driver, you may be asked if you want to use a proprietary driver
instead with more features (3D effects for example).

Monitor:

In the same way as above, the monitor currently detected is displayed and you can click on the
button to change to another one. If the desired monitor isn't in the Vendor list, choose in the Generic
list a monitor with the same features.

Resolution:

This button allows the choice of the resolution (number of pixels) and the colour depth (number of
colours). It displays this screen:

When you change the color depth, a multi-colored bar will appear next to the second button and
show a preview of what the selected color depth looks like.

The first button shows the currently resolution, click to change for another one. The list gives all the
possible choices according to the graphic card and the monitor, it is possible to click on Other to set
other resolutions, but bear in mind that you can damage your monitor or select an uncomfortable
setting.

The second button shows the currently colour depth, click to change this for another one.

Depending on the chosen resolution, it may be necessary to logout and restart the
graphical environment for the settings to take effect.

Test:

Once the configuration done, it is recommended to do a test before clicking on OK because it is
easier to modify the settings now than later if the graphical environment doesn't work.

14You can start this tool from the command line, by typing XFdrake as normal user or drakx11 as root. Mind the capital letters.
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In case of a non working graphical environment, type Alt+Ctrl+F2 to open a text environ-
ment, connect as root and type XFdrake (with the caps) to to use XFdrake's text version.

If the test fails, just wait until the end, if it works but you don't want to change after all, click on No,
if everything is right, click on OK.

Opcje:

1. Global options: If Disable Ctrl-Alt-Backspace is checked, it will no longer be possible to restart
X server using Ctrl+Alt+Backspace keys.

2. Graphic card options: Allows you to enable or disable three specific features depending on the
graphic card.

3. Graphical interface at startup: Most of the time, Automatically start the graphical interface (Xorg)
upon booting is checked to make the boot switch to graphical mode, it may be unchecked for
a server.

After a click on the Quit button, the system will ask you to confirm. There is still time to cancel
everything and keep the previous configuration, or to accept. In this case, you have to disconnect
and reconnect to activate the new configuration.

5.5. Set up the Keyboard Layout
keyboarddrake

5.5.1. Wprowadzenie

The keyboarddrake tool15 helps you configure the basic layout for the keyboard that you wish to
use on Mageia. It affects the keyboard layout for all users on the system. It can be found in the
Hardware section of the Mageia Control Center (MCC) labelled "Configure mouse and keyboard".

5.5.2. Układ klawiatury

Here you can select which keyboard layout you wish to use. The names (listed in alphabetical order)
describe the language, country, and/or ethnicity each layout should be used for.

5.5.3. Typ klawiatury

This menu lets you select the type of keyboard you are using. If you are unsure of which to choose,
it is best to leave it as the default type.

5.6. Konfiguracja urządzeń wskazujących (mysz, touchpad)
mousedrake

This tool16 is present in the Mageia Control Center under the tab Hardware.

As you must have a mouse to install Mageia, that one is already installed by Drakinstall. This tool
allows installation of another mouse.

15You can start this tool from the command line, by typing keyboarddrake as root.
16You can start this tool from the command line, by typing mousedrake as root.
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The mice are sorted by connection type and then by model. Select your mouse and click on OK.
Most of the time "Universal / Any PS/2 & USB mice" is suitable for a recent mouse. The new mouse
is immediately taken into account.

5.7. Install and configure a printer
system-config-printer

5.7.1. Wprowadzenie

Printing is managed on Mageia by a server named CUPS. It has its own configuration interface
[http://localhost:631] which is accessible via an Internet browser, but Mageia offers its own tool
for installing printers called system-config-printer which is shared with other distributions such as
Fedora, Mandriva, Ubuntu and openSUSE.

You should enable the non-free repository before proceeding with the installation, because some
drivers may only be available in this way.

Printer installation is carried out in the Hardware section of the Mageia Control Centre. Select the
Configure printing and scanning tool17.

MCC will ask for the installation two packages:

task-printing-server

task-printing-hp

It is necessary to accept this installation to continue. Up to 230MB of dependencies are needed.

To add a printer, choose the "Add" printer button. The system will try to detect any printers and
the ports available. The screenshot displays a printer connected to a parallel port. If a printer is
detected, such as a printer on a USB port, it will be displayed on the first line. The window will also
attempt to configure a network printer.

5.7.2. Automatically detected printer

This usually refers to USB printers. The utility automatically finds the name of the printer and displays
it. Select the printer and then click "Next". If there is a known driver associated for the printer, it
will be automatically installed. If there is more than one driver or no known drivers, a window will
ask you to select or furnish one, as explained in the next paragraph. Continue with Sekcja 5.7.4,
„Complete the installation process”

5.7.3. No automatically detected printer

When you select a port, the system loads a driver list and displays a window to select a driver. The
choice can be made through one of the following options.

• Select printer from database

• provide PPD file

• search for a driver to download

By selecting from the database, the window suggests a printer manufacturer first, and then a device
and a driver associated with it. If more than one driver is suggested, select one which is recom-

17You can start this tool from the command line, by typing system-config-printer. The root password will be asked for.
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mended, unless you have encountered some problems with that one before, in this case select the
one which know to work.

5.7.4. Complete the installation process

After the driver selection, a window requests some information which will allow the system to de-
signate and discover the printer. The first line is the name under which the device will appear in
applications in the list of available printers. The installer then suggests printing a test page. After
this step, the printer is added and appears in the list of available printers.

5.7.5. Network printer

Network printers are printers that are attached directly to a wired or wireless network, that are
attached to a printserver or that are attached to another workstation that serves as printserver.

Often, it is better to configure the DHCP server to always associate a fixed IP address
with the printer's MAC-address. Of course that should be the same as the IP address
the printer of printserver is set to, if it has a fixed one.

The printer's Mac-address is a serial number given to the printer or printserver or computer it is
attached to, that can be obtained from a configuration page printed by the printer or which may be
written on a label on the printer or printserver. If your shared printer is attached to a Mageia system,
you can run ifconfig on it as root to find the MAC-address. It is the sequence of numbers and
letters after "HWaddr".

You can add your network printer by choosing the protocol it uses to talk to your computer over the
network. If you don't know which protocol to choose, you can try the Network Printer - Find Network
Printer option in the Devices menu and give the IP address of the printer in the box on the right,
where it says "host".

If the tool recognises your printer or printserver, it will propose a protocol and a queue, but you
can choose a more appropriate one from the list below it or give the correct queue name if it isn't
in the list.

Look in the documentation that came with your printer or printserver to find which protocol(s) it
supports and for possible specific queue names.

5.7.6. Network printing protocols

One current technique is one developed by Hewlett-Packard and known as JetDirect. It allows
access to a printer directly connected to the network via an Ethernet port. You must know the IP-
address at which the printer is known on the network. This technique is also used inside some
ADSL-routers which contain an USB port to connect the printer. In this case, the IP-address is that of
the router. Note that the tool "Hp Device manager" can manage dynamically configured IP-adress,
setting an URI like hp:/net/<name-of-the-printer> . In this case, fixed IP-adress is not required.

Choose the option AppSocket/HP JetDirect as the protocol and set the address in Host:, do not
change the Port Number, unless you know that it needs to be changed. After the selection of the
protocol, the selection of the driver is the same as above.

The other protocols are:

• Internet Printing Protocol (ipp): a printer which can be accessed on a TCP/IP network via the IPP
protocol, for example a printer connected to a station using CUPS. This protocol may also be
used also by some ADSL-routers.
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• Internet Printing Protocol (https): the same as ipp, but using http transport and with TLS secured
protocol. The port has to be defined. By default, the port 631 is used.

• Internet Printing Protocol (ipps): the same as ipp, but with TLS secured protocol.

• LPD/LPR host or Printer: a printer which can be accessed on a TCP/IP network via the LPD
protocol, for example a printer connected to a station using LPD.

• Windows printer via SAMBA: a printer connected to a station running Windows or a SMB server
and shared.

The URI can also be added directly. Here are some examples on how to form the URI:

• Appsocket

socket://ip-address-or-hostname:port

• Internet Printing Protocol (IPP)

ipp://ip-address-or-hostname:port-number/resource

http://ip-address-or-hostname:port-number/resource

• Line Printer Daemon (LPD) Protocol

lpd://username@ip-address-or-hostname/queue

Additional information can be found in the CUPS documentation. [http://www.cups.org/documenta-
tion.php/doc-1.5/network.html]

5.7.7. Device Properties

You can access the properties of the device. The menu allows access to parameters for the CUPS
server. By default a CUPS server is launched on your system, but you can specify a different one
with the Server | Connect... menu, another window which gives access to the tuning of other specific
parameters of the server, following Server | Settings.

5.7.8. Troubleshoot

You can find some information on occurring errors during printing by inspecting /var/log/cups/
error_log

You can also access to a tool to diagnose problems using the Help | Troubleshoot menu.

5.7.9. Specifics

It is possible that some drivers for specific printers are not available in Mageia or are not functional.
In this case, have a look at the openprinting [http://openprinting.org/printers/] site to check if a driver
for your device is available. If yes, check if the package is already present in Mageia and in this
case install it manually. Then, redo the installation process to configure the printer. In all cases,
report the problem in bugzilla or on the forum if you are comfortable with this tool and furnish the
model and driver information and whether the printer works or not after installation. Here are some
sources to find other up-to-date drivers or for more recent devices.

Brother printers

This page [http://welcome.solutions.brother.com/bsc/public_s/id/linux/en/download_prn.html] give
a list of drivers provided by Brother. Search the driver for your device, download the rpm(s) and
install.
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You should install Brother drivers before running the configuration utility.

Hewlett-Packard printers and All in one devices

These devices use the hplip tool. It is installed automatically after the detection or the selection of
the printer. You can find other information here [http://hplipopensource.com/hplip-web/index.html].
The tool "HP Device Manager" is available in the System menu. Also view configuration [http://
hplipopensource.com/hplip-web/install/manual/hp_setup.html] for the management of the printer.

A HP All in one device must be installed as a printer and the scanner features will be added. Note
that sometimes, the Xsane interface doesn't allow to scan films or slides (the lighting slid can't
operate). In this case, it is possible to scan, using the standalone mode, and save the picture on a
memory card or USB stick inserted in the device. Afterwards, open your favourite imaging software
and load your picture from the memory card which is appeared in the /media folder.

Samsung colour printer

For specific Samsung and Xerox colour printers, this site provides drivers [http://foo2qpdl.rkk-
da.com/] for the QPDL protocol.

Epson printers and scanners

Drivers for Epson printers are available from this search page [http://download.ebz.epson.net/dsc/
search/01/search/?OSC=LX]. For the scanner part, you must install the "iscan-data" package first,
then "iscan" (in this order). A iscan-plugin package can also be available and is to install. Choose
the rpm packages according to your architecture.

It is possible that the iscan package will generate a warning about a conflict with sane. Users have
reported that this warning can be ignored.

Canon printers

For Canon printers, it may be advisable to install a tool named turboprint available here  [http://
www.turboprint.info/].

5.8. Konfiguracja skanera
scannerdrake

5.8.1. Instalacja

This tool 18 allows you to configure a single scanner device or a multifunction device which inclu-
des scanning. It also allows you to share local devices connected to this computer with a remote
computer or to access remote scanners.

When you start this tool for the first time, you may get the following message:

"SANE packages need to be installed to use scanners

Do you want to install the SANE packages?"

Choose Yes to continue. It will install scanner-gui and task-scanning if they are not yet in-
stalled.

If your scanner is identified correctly, so if in the above screen you see the name of your scanner,
the scanner is ready for use with, for instance, XSane or Simple Scan.

18You can start this tool from the command line, by typing scannerdrake as root.
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In that case, you might now want to want to configure the Scanner sharing option. You can read
about it in the Sekcja 5.8.2, „Scannersharing”.

However, if your scanner hasn't been correctly identified, and checking its cable(s) and power swit-
ch and then pressing Search for new scanners doesn't help, you'll need to press Add a scanner
manually.

Choose the brand of your scanner in the list you see, then its type from the list for that brand and
click Ok

If you can't find your scanner in the list, then click Cancel

Please check whether your scanner is supported on the SANE: Supported Devices
[http://www.sane-project.org/lists/sane-mfgs-cvs.html] page and ask for help in the fo-
rums [http://forums.mageia.org/en/].

Rysunek 1. Choose port

You can leave this setting to Auto-detect available ports unless your scanner's interface is a parallel
port. In that case, select /dev/parport0 if you have only one.

After clicking Ok, in most cases you will see a screen similar to the one below.

If you don't get that screen, then please read the Sekcja 5.8.4, „Extra installation steps”.

5.8.2. Scannersharing

Here you can choose whether the scanners connected to this machine should be accessible by
remote machines and by which remote machines. You can also decide here whether scanners on
remote machines should be made available on this machine.

Scanner sharing to hosts : name or IP address of hosts can be added or deleted from the list of
hosts allowed to access the local device(s), on this computer.

Usage of remote scanners : name or IP address of hosts can added or deleted from the list of hosts
which give access to a remote scanner.

Scanner sharing to hosts: you can add host.

Scanner sharing to hosts: specify which host(s) to add, or allow all remote machines.

"All remote machines" are allowed to access the local scanner.

If the package saned is not yet installed, the tool offers to do it.

At the end, the tool will alter these files:

/etc/sane.d/saned.conf

/etc/sane.d/net.conf

/etc/sane.d/dll.conf to add or comment the directive "net"
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It will also configure saned and xinetd to be started on boot.

5.8.3. Specifics

• Hewlett-Packard

Most HP scanners are managed from HP Device Manager (hplip) which also manages printers.
In this case, this tool does not allow you to configure it and invites you to use HP Device Manager.

• Epson

Drivers are available from this page [http://download.ebz.epson.net/dsc/search/01/sear-
ch/?OSC=LX]. When indicated, you must install the iscan-data package first, then iscan (in this
order). It is possible that the iscan package will generate a warning about a conflict with sane.
Users have reported that this warning can be ignored.

5.8.4. Extra installation steps

It is possible that after selecting a port for your scanner in the Rysunek 1, „Choose port” screen,
you need to take one or more extra steps to correctly configure your scanner.

• In some cases, you're told the scanner needs its firmware to be uploaded each time it is started.
This tool allows you to load it into the device, after you installed it on your system. In this screen
you can install the firmware from a CD or a Windows installation, or install the one you downloaded
from an Internet site of the vendor.

When your device's firmware needs to be loaded, it can take a long time at each first usage,
possibly more than one minute. So be patient.

• Also, you may get a screen telling you to adjust the /etc/sane.d/"name_of_your_SANE_backen-
d".conf file.

• Read those or other instructions you get carefully and if you don't know what to do, feel free to
ask for help in the forums [http://forums.mageia.org/en/].

5.9. Konfiguracja UPS do monitorowania napięcia
drakups

This page hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

You can start this tool from the command line, by typing drakups as root.

6. Network and Internet

In this screen you can choose between several network tools. Click on a link below to learn more.

1. Zarządzanie urządzeniami sieciowymi

a. Sekcja 6.1, „Centrum konfiguracji sieci”

b. Sekcja 6.2, „Konfiguracja nowego interfejsu sieciowego (LAN, ISDN, ADSL, ...)”

c. Sekcja 6.3, „Usuwanie połączenia”

2. Personalizacja i bezpieczeństwo twojej sieci

a. Sekcja 6.4, „Pośrednik”
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b. Sekcja 6.5, „Udostępnianie połączenia internetowego innym komputerom w sieci”

c. Sekcja 6.6, „Zarządzanie profilami sieciowymi”

d. Sekcja 6.7, „Configure VPN Connection to secure network access”

3. Inne

a. Sekcja 6.8, „Definicje hostów”

6.1. Centrum konfiguracji sieci
draknetcenter

This tool19 is found under the Network & Internet tab in the Mageia Control Center labelled "Network
Center"

6.1.1. Wprowadzenie

When this tool is launched, a window opens listing all the networks configured on the computer,
whatever their type (wired, wireless, satellite, etc.). When clicking on one of them, three or four
buttons appear, depending on the network type, to allow you to look after the network, change its
settings or connect/disconnect. This tool isn't intended to create a network, for this see Set up a
new network interface (LAN, ISDN, ADSL, ...) in the same MCC tab.

In the screenshot below, given as example, we can see two networks, the first one is wired and
connected, recognizable by this icon  (this one is not connected  ) and the second section shows
wireless networks, not connected recognizable by this icon  and this one if connected. For
the other network types, the colour code is always the same, green if connected and red if not
connected.

In the wireless part of the screen, you can also see all the detected networks, with the SSID, the
Signal strengh, if they are encrypted (in red) or not (in green), and the Operating mode. Click on
the chosen one and then either on Monitor, Configure or Connect. It is possible here to go from a
network to another one. If a private network is selected, the Network Settings window (see below)
will open and ask you for extra settings ( an encryption key in particular).

Click on Refresh to update the screen.

6.1.2. The Monitor button

This button allows you to watch the network activity, downloads (toward the PC, in red) and uploads
(toward the Internet, in green). The same screen is available by right clicking on the Internet icon
in the system tray -> Monitor Network.

There is a tab for each network (here eth0 is the wired network, lo the local loopback and wlan0 the
wireless network) and a tab connection which gives details about connection status.

At the bottom of the window is a title Traffic accounting, we will look at that in the next
section.

19You can start this tool from the command line, by typing draknetcenter as root.
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6.1.3. The Configure button

A - For a wired network

It is possible to change all the settings given during network creation. Most of the time, checking
Automatic IP (BOOTP/DHCP) will do, but in case of problems, manual configuration may give better
results.

For a residential network, the IP address always looks like 192.168.0.x, Netmask is 255.255.255.0,
and the Gateway and DNS servers are available from your providers website.

Enable traffic accounting if checked this will count the traffic on a hourly, daily or monthly basis.
The results are visible in the Network monitor detailed in the previous section. Once enabled, you
may have to reconnect to the network.

Allow interface to be controlled by Network Manager:

This section hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

The button Advanced:

This section hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

B - For a wireless network

Only the items not already seen above are explained.

Operating mode:

Select Managed if the connection is via an access point, there is an ESSID detected. Select Ad-
hoc if it is a peer to peer network. Select Master if your network card is used as the access point,
your network card needs to support this mode.

Encryption mode and Encryption key:

If it is a private network, you need to know these settings.

WEP uses a password and is weaker than WPA which uses a passphrase. WPA Pre-Shared Key
is also called WPA personal or WPA home. WPA Enterprise is not often used in private networks.

Allow access point roaming:

Roaming is a technology which enables allows computer to change its access point while remaining
connected to the network.

The button Advanced:

This page hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

6.1.4. The Advanced Settings button

This section hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.
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6.2. Konfiguracja nowego interfejsu sieciowego (LAN, ISDN, ADSL, ...)
drakconnect

6.2.1. Wprowadzenie

This tool20 allows to configure much of local network or Internet access. You have to know some
information from your access provider or your network administrator.

Select the type of connection you want to set, according to which hardware and provider you have.

6.2.2. A new Wired connection (Ethernet)

1. The first window lists the interfaces which are available. Select the one to configure.

2. At this point, the choice is given between an automatic or a manual IP address.

3. Automatic IP

a. Ethernet/IP settings: you have to select if DNS servers are declared by the DHCP server or
are manually specified, as explained below. In the last case, the IP address of DNS servers
has to be set. The HOSTNAME of the computer can be specified here. If no HOSTNAME
is specified, the name localhost.localdomain is attributed by default. The Hostname
can also be provided by the DHCP server with the option Assign host name from DHCP
server. Not all DHCP servers have such a function and if you're setting up your PC to get
an IP address from a domestic ADSL router, it is unlikely.

b. The advanced button give the opportunity to specify:

• Search domain (not accessible, as provided by the DHCP server)

• the DHCP client

• DHCP timeout

• Get YP server from DHCP (checked by default): specify the NIS server

• Get NTPD server from DHCP (synchronisation of clocks)

• the HOSTNAME required by DHCP. Only use this option if the DHCP server requires the
client to specify a hostname before receiving an IP address. This option is not dealt by
some DHCP servers.

c. After accepting, the last steps which are common to all connection configurations are expla-
ined: Sekcja 6.2.11, „Ending the configuration”

4. Konfiguracja ręczna

a. Ethernet/IP settings: you need to declare what DNS servers to use. The HOSTNAME of
the computer can be specified here. If no HOSTNAME is specified, the name localho-
st.localdomain is attributed by default.

For a residential network, the IP address usually looks like 192.168.x.x, Netmask is
255.255.255.0, and the Gateway and DNS servers are available from your service provi-
der's website.

In advanced settings, you can specified a Search domain. It would usually be your home
domain, i.e. if your computer is called "splash", and it's full domain name is "splash.boatan-

20You can start this tool from the command line, by typing drakconnect as root.
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chor.net", the Search Domain would be "boatanchor.net". Unless you specifically need it,
it's ok not to define this setting. Again, domestic ADSL would not need this setting.

b. The next steps are exposed at Sekcja 6.2.11, „Ending the configuration”

6.2.3. A new Satellite connection (DVB)

This section hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

6.2.4. A new Cable modem connection

1. The first window lists the interfaces which are available. Select the one to configure.

2. At this point, the choice is given between an automatic or a manual IP address.

3. You have to specify a authentication method:

• Brak

• BPALogin (necessary for Telstra). In this case you have to provide User name and password.

4. Automatic IP

a. Cable/IP settings: you have to select if DNS servers are declared by the DHCP server or
are manually specified, as explained below. In the last case, the IP address of DNS servers
has to be set. The HOSTNAME of the computer can be specified here. If no HOSTNAME
is specified, the name localhost.localdomain is attributed by default. The Hostname
can also be provided by the DHCP server with the option Assign host name from DHCP
server. Not all DHCP servers have such a function and if you're setting up your PC to get
an IP address from a domestic ADSL router, it is unlikely.

b. The advanced button give the opportunity to specify:

• Search domain (not accessible, as provided by the DHCP server)

• the DHCP client

• DHCP timeout

• Get YP server from DHCP (checked by default): specify the NIS server

• Get NTPD server from DHCP (synchronisation of clocks)

• the HOSTNAME required by DHCP. Only use this option if the DHCP server requires the
client to specify a hostname before receiving an IP address. This option is not dealt by
some DHCP servers.

c. After accepting, the last steps which are common to all connection configurations are expla-
ined: Sekcja 6.2.11, „Ending the configuration”

5. Konfiguracja ręczna

a. Cable/IP settings: you need to declare what DNS servers to use. The HOSTNAME of the
computer can be specified here. If no HOSTNAME is specified, the name localhost.lo-
caldomain is attributed by default.

For a residential network, the IP address usually looks like 192.168.x.x, Netmask is
255.255.255.0, and the Gateway and DNS servers are available from your service provi-
der's website.

In advanced settings, you can specified a Search domain. It would usually be your home
domain, i.e. if your computer is called "splash", and it's full domain name is "splash.boatan-
chor.net", the Search Domain would be "boatanchor.net". Unless you specifically need it,
it's ok not to define this setting. Again, domestic connection would not need this setting.
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b. The next steps are exposed at Sekcja 6.2.11, „Ending the configuration”

6.2.5. A new DSL connection

1. If the tool detects network interfaces, it offers to select one and to configure it.

2. A list of providers is proposed, classified by countries. Select your provider. If it is not listed,
select the option Unlisted and then enter the options your provider gave.

3. Select one of the protocols available:

• Protokół dynamicznej konfiguracji komputera (DHCP)

• Konfiguracja ręczna TCP/IP

• PPP over ADSL (PPPoA)

• PPP przez Ethernet (PPPoE)

• Protokół tunelowania punkt-do-punktu (PPTP)

4. Ustawienia dostępu

• Konto (nazwa użytkownika)

• Account password

• (Advanced) Virtual Path ID (VPI)

• (Advanced) Virtual Circuit ID (VCI)

5. The next steps are exposed at Sekcja 6.2.11, „Ending the configuration”

6.2.6. A new ISDN connection

1. The wizard asks which device to configure:

• Manual choice (internal ISDN card)

• Zewnętrzny modem ISDN

2. A list of hardware is proposed, classified by category and manufacturer. Select your card.

3. Select one of the protocols available:

• Protocol for the rest of the world, except Europe (DHCP)

• Protocol for Europe (EDSS1)

4. A list of providers is then offered, classified by countries. Select your provider. If it is not listed,
select the option Unlisted and then enter the options your provider gave you. Then it is asked
for parameters:

• Nazwa połączenia

• Numer telefonu

• Identyfikator logowania

• Account password

• Metoda uwierzytelniania

5. After that, you have to select if you get the IP address by automatic or manual method. In the
last case, specify IP address and Subnet mask.

6. The next step is to choose how DNS servers address are obtained, by automatic or manual
method. In the case of manual configuration, you have to put:

• Domena
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• Pierwszy i drugi serwer DNS

• Select if the hostname is set from IP. This option is to select only if you are sure that your
provider is configured to accept it.

7. The next step is to choose how the gateway address is obtained, by automatic or manual me-
thod. In the case of manual configuration, you have to enter the IP address.

8. The next steps are exposed at Sekcja 6.2.11, „Ending the configuration”

6.2.7. A new Wireless connection (WiFi)

1. A first window lists the interfaces which are available and an entry for Windows driver (ndisw-
rapper). Select the one to configure. Use ndiswrapper only if the other configuration methods
did not work.

2. At this step, the choice is given between the different access points that the card has detected.

3. Specific parameter for the wireless card are to provide:

• Operating mode:

Zarządzany To access to an existing access point (the most frequent).

Ad-Hoc To configure direct connection between computers.

• Network Name (ESSID)

• Encryption mode: it depends of how the access point is configured.

WPA/
WPA2

This encryption mode is to prefer if your hardware allows it.

WEP Some old hardware deals only this encryption method.

• Klucz szyfrujący

It is generally provided with the hardware which give the access point.

4. At this step, the choice is given between an automatic IP address or a manual IP address.

5. Automatic IP

a. IP settings: you have to select if DNS servers are declared by the DHCP server or are
manually specified, as explained below. In the last case, IP address of DNS servers has
to be set. The HOSTNAME of the computer can be specified here. If no HOSTNAME is
specified, the name localhost.localdomain is attributed by default. The Hostname can also
be provided by the DHCP server with the option Assign host name from DHCP server

b. The advanced button give the opportunity to specify:

• Search domain (not accessible, as provided by the DHCP server)

• the DHCP client

• DHCP timeout

• Get YP server from DHCP (checked by default): specify the NIS servers

• Get NTPD server from DHCP (synchronisation of clocks)

• the HOSTNAME required by DHCP. Only use this option if the DHCP server requires the
client to specify a hostname before receiving an IP address. This option is not dealt by
some DHCP servers.

c. After accepting the configuration the step, which is common to all connection configurations,
is explained: Sekcja 6.2.11, „Ending the configuration”

6. Konfiguracja ręczna
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a. IP settings: you have to declare DNS servers. The HOSTNAME of the computer can be
specified here. If no HOSTNAME is specified, the name localhost.localdomain is
attributed by default.

For a residential network, the IP address always looks like 192.168.x.x, Netmask is
255.255.255.0, and the Gateway and DNS servers are available from your providers we-
bsite.

In advanced settings, you can specified a Search domain. It must seem to your hostname
without the first name, before the period.

b. The next steps are exposed at Sekcja 6.2.11, „Ending the configuration”

6.2.8. A new GPRS/Edge/3G connection

1. If the tool detects wireless interfaces, it offers to select one and to configure it.

2. The PIN is asked. Leave empty if the PIN is not required.

3. The wizard asks for network. If it is not detected, select the option Unlisted.

4. A list of providers is proposed, classified by countries. Select your provider. If it is not listed,
select the option Unlisted and then enter the options your provider gave.

5. Provide access settings

• Nazwa punktu dostępowego

• Konto (nazwa użytkownika)

• Account password

6. The next steps are exposed at Sekcja 6.2.11, „Ending the configuration”

6.2.9. A new Bluetooth Dial-Up Networking connection

This section hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

6.2.10. A new Analog telephone modem connection (POTS)

1. The wizard asks which device to configure:

• Ręczny wybór

• Detected hardware, if any.

2. A list of ports is proposed. Select your port.

3. If not yet installed, it will be suggested that you install the package kppp-provider.
4. A list of providers is proposed, classified by countries. Select your provider. If it is not listed,

select the option Unlisted and then enter the options your provider gave. Then it is asked for
Dialup options:

• Connection name
• Phone number
• Login ID
• Password
• Authentication, choose between:

– PAP/CHAP

– Oparta o skrypt
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– PAP

– Poprzez terminal

– CHAP

5. The next steps are exposed at Sekcja 6.2.11, „Ending the configuration”

6.2.11. Ending the configuration

In the next step, you can specify:

• Allow users to manage the connection
• Start the connection at boot
• Enable traffic accounting
• Allow interface to be controlled by Network Manager
• In the case of a wireless connection, a supplemental box is Allow access point roaming which

give the possibility to switch automatically between access point according to the signal strength.

With the advanced button, you can specify:

• Metric (10 by default)

• MTU

• Hotplugging sieci

• Włącz tunelowanie IPv6 do IPv4

The last step allows you to specify if the connection is to start immediately or not.

6.3. Usuwanie połączenia
drakconnect --del

Here, you can delete a network interface21.

Click on the drop down menu, choose the one you want to remove and then click next.

You'll see a message that the network interface has been deleted successfully.

6.4. Pośrednik
drakproxy

If you have to use a proxy server to access to the internet, you can use this tool22 to configure it.
Your net administrator will give you the information you need. You can also specify some services
which can be accessed without the proxy by exception.

From Wikipedia, on 2012-09-24, article Proxy server: In computer networks, a proxy server is a
server (a computer system or an application) that acts as an intermediary for requests from clients
seeking resources from other servers. A client connects to the proxy server, requesting some se-
rvice, such as a file, connection, web page, or other resource available from a different server. The
proxy server evaluates the request as a way to simplify and control their complexity.

21You can also start this tool from the command line, by typing drakconnect --del as root.
22You can start this tool from the command line, by typing drakproxy as root.
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6.5. Udostępnianie połączenia internetowego innym komputerom w sieci
drakgw

6.5.1. Principles

This is useful when you have a computer (3) which has Internet (2) access and is connected also to
a local network (1). You can use computer (3) as a gateway to give that access to other workstations
(5) and (6) in the local network (1). For this, the gateway must have two interfaces; the first one such
as an ethernet card must be connected to the local network, and the second one (4) connected
to the Internet (2).

The first step is to verify that the network and the access to Internet are set up, as documented in
Sekcja 6.1, „Centrum konfiguracji sieci”.

6.5.2. Gateway wizard

The wizard23 offers successive steps which are shown below:

• If the wizard does not detect at least two interfaces, it warns about this and asks to stop the
network and configure the hardware.

• specify the interface used for the Internet connection. The wizard automatically suggests one of
the interfaces, but you should verify that what is proposed is correct.

• specify which interface is used for the Lan access. The wizard also proposes one, check that
this is correct.

• The wizard proposes parameters for the Lan network, such as IP address, mask and domain na-
me. Check that these parameters are compatible with the actual configuration. It is recommended
that you accept these values.

• specify if the computer has to be used as a DNS server. If yes, the wizard will check that bind
is installed. Otherwise, you have to specify the address of a DNS server.

• specify if the computer is to be used as a DHCP server. If yes, the wizard will check that dhcp-
server is installed and offer to configure it, with start and end addresses in the DHCP range.

23You can start this tool from the command line, by typing drakgw as root.
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• specify if the computer is to be used as a proxy server. If yes, the wizard will check that squid is
installed and offer to configure it, with the address of the administrator (admin@mydomain.com),
name of the proxy (myfirewall@mydomaincom), the port (3128) and the cache size (100 Mb).

• The last step allows you to check if the gateway machine is connected to printers and to share
them.

You will be warned about the need to check the firewall if it is active.

6.5.3. Configure the client

If you have configured the gateway machine with DHCP, you only need to specify in the network
configuration tool that you get an address automatically (using DHCP). The parameters will be
obtained when connecting to the network. This method is valid whatever operating system the client
is using.

If you must manually specify the network parameters, you must in particular specify the gateway
by entering the IP-address of the machine acting as the gateway.

6.5.4. Stop connection sharing

If you want to stop sharing the connection on the Mageia computer, launch the tool. It will offer to
reconfigure the connection or to stop the sharing.

6.6. Zarządzanie profilami sieciowymi
draknetprofile

This page hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

You can start this tool from the command line, by typing draknetprofile as root.

6.7. Configure VPN Connection to secure network access
drakvpn

6.7.1. Wprowadzenie

This tool24 allows to configure secure access to a remote network establishing a tunnel between
the local workstation and the remote network. We discuss here only of the configuration on the
workstation side. We assume that the remote network is already in operation, and that you have
the connection information from the network administrator, like a .pcf configuration file .

6.7.2. Konfiguracja

First, select either Cisco VPN Concentrator or OpenVPN, depending on which protocol is used for
your virtual private network.

Then give your connection a name.

At the next screen, provide the details for your VPN connection.

• For Cisco VPN

24You can start this tool from the command line, by typing drakvpn as root.
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• For openvpn. The openvpn package and its dependencies will be installed the first time the tool
is used.

Select the files that you received from the network administrator.

Advanced parameters:

The next screen asks for IP-address of the gateway.

When the parameters are set, you have the option of starting the VPN connection.

This VPN connection can be set to start automatically with a network connection. To do this, recon-
figure the network connection to always connect to this VPN.

6.8. Definicje hostów
drakhosts

If some systems on your network grant you services, and have fixed IP-addresses, this tool25 allows
to specify a name to access them more easily. Then you can use that name instead of the IP-
address.

Dodaj

With this button, you add the name for a new system. You will get a window to specify the IP-
address, the host name for the system, and optionally an alias which can be used in the same way
that the name is.

Modyfikuj

You can access the parameters of an entry previously defined. You get the same window.

7. System

In this screen you can choose between several system and administration tools. Click on a link
below to learn more.

1. Zarządzanie usługami systemowymi

a. Sekcja 7.1, „Uwierzytelnianie”

b. Sekcja 7.2, „Zarządzanie usługami systemowymi poprzez ich włączanie i wyłączanie”

c. Sekcja 7.3, „Zarządzanie, dodawanie i usuwanie czcionek. Import czcionek z Windows® ”

2. Lokalizacja

a. Sekcja 7.4, „Ustawienie daty i czasu”

b. Sekcja 7.5, „Zarządzanie lokalizacją systemu”

3. Narzędzia administracyjne

a. Sekcja 7.6, „Przegląd i przeszukiwanie logów systemowych”

25You can start this tool from the command line, by typing drakhosts as root.
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b. Sekcja 7.7, „Otwieranie konsoli jako administrator”

c. Sekcja 7.8, „Użytkownicy i grupy” = Manage users on system

d. Sekcja 7.9, „Import dokumentów i ustawień z systemu Windows ®”

7.1. Uwierzytelnianie
drakauth

This tool26 enables you to modify the manner in which you can be recognized as user of the machine
or on the net.

By default, information for your authentication is stored in a file on your computer. Modify it only if
your network administrator invites you to do so and give information about that.

7.2. Zarządzanie usługami systemowymi poprzez ich włączanie i wyłączanie
drakxservices

This page hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

You can start this tool from the command line, by typing drakxservices as root.

7.3. Zarządzanie, dodawanie i usuwanie czcionek. Import czcionek z Win-
dows®

drakfont

This tool27 is present in the Mageia Control Center under the System tab. It allows you to manage
the fonts available on the computer. The main screen above shows:

• the installed font names, styles and sizes.

• a preview of the selected font.

• some buttons explained here later.

Get Windows Fonts:

This button automatically adds the fonts found on the Windows partition. You must have Microsoft
Windows installed.

Options:

It allows you to specify the applications or devices (printers mostly) able to use the fonts.

Uninstall:

This button is to remove installed fonts and possibly save some place. Be careful when removing
fonts because it may have serious consequences on the documents that use them.

Import:

26You can start this tool from the command line, by typing drakauth as root.
27You can start this tool from the command line, by typing drakfont as root.
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Allows you to add fonts from a third party (CD, internet, ...). The supported formats are ttf, pfa, pfb,
pcf, pfm and gsf. Click on the Import button and then on Add, a file manager pops up where you can
select the fonts to install, click on Install when done. They are installed in the folder /usr/share/fonts.

If the newly installed (or removed) fonts doesn't appear in the Drakfont main screen, close and re
open it to see the modifications.

7.4. Ustawienie daty i czasu
drakclock

This tool28 is found under the tab System in the Mageia Control Center labelled "Manage date and
time". In some desktop environments it is also available by a right click / Adjust date and Time ...
on the clock in the system tray.

It's a very simple tool.

On the upper left part, is the calendar. On the screenshot above, the date is September (on the
upper left), 2012 (on the upper right), the 2nd (in blue) and it is a Sunday. Select the month (or
year) by clicking on the little arrows on each side of September (or 2012). Select the day by clicking
on its number.

On the bottom left is the Network Time Protocol synchronising, it is possible to have a clock always
on time by synchronising it with a server. Check Enable Network Time Protocol and choose the
closest server.

On the right part is the clock. It's useless to set the clock if NTP is enabled. Three boxes display
hours, minutes and seconds (15, 28 and 22 on the screenshot). Use the little arrows to set the
clock to the correct time. The format can't be changed here, see your desktop environment settings
for that.

At least, on the bottom right, select your time zone by clicking on the Change Time Zone button
and choosing in the list the nearest town.

Even if it isn't possible to choose a date or time format in this tool, they will be displayed
on your desktop in accordance with the localisation settings.

7.5. Zarządzanie lokalizacją systemu
localedrake

This tool29 can be found in the System section of the Mageia Control Center (MCC) labelled "Ma-
nage localization for your system". It opens with a window in which you can choose your language.
The choice is adapted to languages selected during installation.

The Advanced button give access to activate compatibility with old encoding (non UTF8).

The second window shows a list of countries according to the selected language. The button Other
Countries gives access to countries not listed.

You have to restart your session after any modifications.

28You can start this tool from the command line, by typing drakclock as root.
29You can also start this tool from the command line, by typing localedrake as root.
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7.5.1. Metoda wejścia

In the Other Countries screen you can also select an input method (from the drop-down menu at the
bottom of the list). Input methods allow users to input multilingual characters (Chinese, Japanese,
Korean, etc).

For Asian and African locales, IBus will be set as default input method so users should not need
to configure it manually.

Other input methods (SCIM, GCIN, HIME, etc.) also provide similar functions and can, if not ava-
ilable from the drop-down menu, be installed in another part of the Mageia Control Center. See
Sekcja 2.1, „Software Management (Install and Remove Software)”.

7.6. Przegląd i przeszukiwanie logów systemowych
logdrake

This tool30 is found in the Mageia Control Center System tab, labelled "View and search system
logs".

7.6.1. To do a search in the logs

First, enter the key string you want to look for in the Matching field and/or the key string you want
to do not wish to see amongst the answers in the field but not matching. Then select the file(s) to
search in the Choose file field. Optionally, it is possible to limit the search to only one day. Select
it in the Calendar, using the little arrows on each side of the month and year, and check "Show
only for the selected day". At last, click on the search button to see the results in the window called
Content of the file. It is possible to save the results in the .txt format by clicking on the Save button.

The Mageia Tools Logs houses the logs from the Mageia configuration tools such as
the Mageia Control Center tools. These logs are updated each time a configuration is
modified.

7.6.2. To configure a mail alert

Mail alert automatically checks the system load and the services every hour and if necessary sends
an e-mail to the configured address.

To configure this tool, click on the Mail Alert button and then, in the next screen, on the Configure
the mail alert system drop down button. Here, all the running services are displayed and you can
choose which ones you want to look watch. (See screenshot above).

The following services can be watched :

• Usługa webmin

• Serwer pocztowy Postfix

• Serwer FTP

• Serwer WWW Apache

• Serwer SSH

30You can start this tool from the command line, by typing logdrake as root.
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• Serwer Samba

• Usługa Xinetd

• BIND Domain Name Resolve

In the next screen, select the Load value you consider unacceptable. The load represents the de-
mand to a process, a high load slows the system down and a very high load may indicate that a
process has gone out of control. The default value is 3. We recommend setting the load value to
3 times the number of processors.

In the last screen, enter the Email address of the person to be warned and the Email server to use
(local or on the Internet).

7.7. Otwieranie konsoli jako administrator
drakconsole

This tool31 gives you access to a console which is directly opened as root. We do not think that you
need more information about that.

7.8. Użytkownicy i grupy
userdrake

This tool32 is found under the System tab in the Mageia Control Center labelled "Manage users
on system"

The tool allows an administrator to manage the users and the groups, this means to add or delete
a user or group and to modify user and group settings (ID, shell, ...)

When userdrake is opened, all the users existing on the system are listed in the Users tab, and all
the groups in the Groups tab. Both tabs operate the same way.

1 Add User

This button opens a new window with all fields shown empty:

The field Full Name is intended for the entry of a family name and first name, but it is possible to
write anything or nothing as well!

Login is the only required field.

Setting a Password is highly recommended. There is a little shield on the right, if it is red, the
password is weak, too short or is too similar to the login name. You should use figures, lower and
upper case characters, punctuation marks, etc. The shield will turn orange and then green as the
password strength improves.

Confirm Password field is there to ensure you entered what you intended to.

Login Shell is a drop down list that allows you to change the shell used by the user you are adding,
the options are Bash, Dash and Sh.

31You can start this tool from the command line, by typing drakconsole as root.
32You can start this tool from the command line, by typing userdrake as root.
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Create a private group for the user, if checked will automatically create a group with the same
name and the new user as the only member (this may be edited).

The other options should be obvious. The new user is created immediately after you click on OK.

2 Add Group

You only need to enter the new group name, and if required, the specific group ID.

3 Edit (a selected user)

User Data: Allows you to modify all the data given for the user at creation (the ID can't be changed).

Account Info:

The first option is for setting an expiration date for the account. Connection is impossible after this
date. This is useful for temporary accounts.

The second option is to lock the account, connection is impossible as long as the account is locked.

It is also possible to change the icon.

Password Info: Allows you to set an expiration date for the password, this forces the user to change
his password periodically.

Group: Here you can select the groups that the user is a member of.

If you are modifying a connected user account, modifications will not be effective until
his/her next login.

4 Edit (with a group selected)

Group Data: Allows you to modify the group name.

Group Users: Here you can select the users who are members of the group

5 Delete

Select a user or a group and click on Delete to remove it. For a user, a window appears to ask if
home directory and mailbox must also be deleted. If a private group has been created for the user,
it will be deleted as well.

It is possible to delete a group which is not empty.

6 Refresh

The User database can be changed outside of Userdrake. Click on this icon to refresh the display.

7 Guest Account

guest is a special account. It is intended to give somebody temporary access to the system with
total security. Login is xguest, there is no password, and it is impossible to make modifications to
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the system from this account. The personal directories are deleted at the end of the session. This
account is enabled by default, to disable it, click in the menu on Actions -> Uninstall guest account.

7.9. Import dokumentów i ustawień z systemu Windows ®
transfugdrake

This tool33 is found under the System tab in the Mageia Control Center labeled Import Windows(TM)
documents and settings

The tool allows an administrator to import the user documents and settings from a Windows® 2000,
Windows® XP or Windows® Vista™ installation on the same computer as the Mageia installation.

Please note that all the changes will be applied by transfugdrake immediately after pres-
sing Next.

After starting transfugdrake you will see the first wizard page with some explanation about the tool
and import options.

As soon as you read and understand the instructions, press the Next button. This should run a
detection of Windows® installation.

When the detection step is complete you will see a page which allows you to choose accounts in
Windows® and Mageia for the import procedure. It is possible to choose other user account than
yours own.

Please take into account that due to migrate-assistant (the backend of transfugdrake)
limitations Windows® user account names with special symbols can be displayed in-
correctly.

Migration may take some time depending on the size of the document folders.

Some Windows® applications (especially drivers) may create user accounts for different
purposes. For example, NVidia drivers in Windows®are updated using UpdatusUser.
Please do not use such accounts for the import purposes.

When you finished with the accounts selection press Next button. The next page is used to select
a method to import documents:

Transfugdrake is designed to import Windows® data from My Documents, My Music and My Pic-
tures folders. It is possible to skip import by selecting the appropriate item in this window.

When you finished with the document import method choosing press Next button. The next page
is used to select a method to import bookmarks:

33You can start this tool from the command line, by typing transfugdrake as root.
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Transfugdrake can import Internet Explorer and Mozilla Firefox bookmarks into the bookmarks of
Mageia Mozilla Firefox instance.

Choose the preferred import option and press the Next button.

The next page allows you to import desktop background:

Choose the preferred option and press the Next button.

The last page of wizard shows some congratulation message. Just press the Finish button.

7.10. Zrzuty danych
draksnapshot-config

This tool34 is available in MCC's System tab, in the Administration tools section.

When you start this tool in MCC for the first time, you will see a message about installing draksnap-
shot. Click on Install to proceed. Draksnapshot and some other packages it needs will be installed.

Click again on Snapshots, you will see the Settings screen. Tick Enable Backups and, if you want
to backup the whole system, Backup the whole system.

If you only want to backup part of your directories, then choose Advanced. You will see a little pop-
up screen. Use the Add and Remove buttons next to the Backup list to include or exclude directories
and files from the backup. Use the same buttons next to the Exclude list to remove subdirectories
and/or files from the chosen directories, that should not be included in the backup. Click on Close
when you are done.

Now give the path to Where to backup, or choose the Browse button to select the correct path. Any
mounted USB-key or external HD can be found in /run/media/your_user_name/.

Click on Apply to make the snapshot.

8. Udostępnianie plików

In this screen you can choose between several tools for sharing drives and directories. Click on a
link below to learn more.

1. Konfiguracja udziałów Windows (R)

a. Sekcja 8.1, „Dostęp do napędów i katalogów udostępnianych przez systemy Windows
(SMB)”

b. Sekcja 8.2, „Share directories and drives with Samba” = Share drives and directories with
Windows (SMB) systems

2. Konfiguracja udziałów NFS

a. Sekcja 8.3, „Dostęp do udostępnianych napędów i katalogów NFS”

b. Sekcja 8.4, „Udostępnianie napędów i katalogów z użyciem NFS”
34You can start this tool from the command line, by typing draksnapshot-config  as root.
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3. Konfiguracja udziałów WebDAV

a. Sekcja 8.5, „Dostęp do napędów i katalogów udostępnianych przez WebDAV”

8.1. Dostęp do napędów i katalogów udostępnianych przez systemy Windows
(SMB)

diskdrake --smb

8.1.1. Wprowadzenie

This tool35 allows you to declare which shared directories to be accessible to all users on the ma-
chine. The protocol used for this is SMB which has been popularized on Windows(R) systems. The
shared directory will be available directly at boot. Shared directories can be also accessed directly
in a single session by a user with tools such as file browsers.

Before starting the tool, it is a good idea to declare the names of available servers, for example
with Sekcja 6.8, „Definicje hostów”

8.1.2. Procedura

Select search servers to obtain a list of servers who share directories.

Click on the server name and on > before the server name to display the list of the shared directories
and select the directory you want to access.

The Mount point button will become available, you have to specify where to mount the directory.

After choosing the mount point, it can be mounted with the Mount button. You can also verify and
change some options with the Options button.

In options, you can specify the user name and the password of those able to connect to the SMB
server. After mounting the directory, you can unmount it with the same button.

After accepting the configuration with the Done button, a message will ask "Do you want to save the /
etc/fstab modifications". Saving, will allow directory to made available at each boot, if the network
is accessible. The new directory is then available in your file browser, for example in dolphin.

8.2. Share directories and drives with Samba
draksambashare

8.2.1. Wprowadzenie

Samba is a protocol used in different Operating Systems to share some resources like directories
or printers. This tool allows you to configure the machine as a Samba server using the protocol
SMB/CIFS. This protocol is also used by Windows(R) and workstations with this OS can access
the resources of the Samba server.

35You can start this tool from the command line, by typing diskdrake --smb as root.
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8.2.2. Preparation

To be accessed from other workstations, the server has to have a fixed IP address. This can be
specified directly on the server, for example with , or at the DHCP server which identifies the sta-
tion with its MAC-address and give it always the same address. The firewall has also to allow the
incoming requests to the Samba server.

8.2.3. Wizard - Standalone server

At the first run, the tools 36 checks if needed packages are installed and proposes to install them if
they are not yet present. Then the wizard to configure the Samba server is launched.

In the next window the Standalone server configuration option is already selected.

Then specify the name of the workgroup. This name should be the same for the access to the
shared resources.

The netbios name is the name which will be used to designate the server on the network.

Choose the security mode:

• user: the client must be authorized to access the resource

• share: the client authenticates itself separately for each share

You can specify which hosts are allowed to access the resources, with IP address or host name.

Specify the server banner. The banner is the way this server will be described in the Windows
workstations.

The place where Samba can log information can be specified at the next step.

The wizard displays a list of the chosen parameters before you accept the configuration. When
accepted, the configuration will be written in /etc/samba/smb.conf.

8.2.4. Wizard - Primary domain controller

If the "Primary domain controller" option is selected, the wizard asks for indication if Wins is to
support or not and to provide admin users names. The following steps are then the same as for
standalone server, except you can choose also the security mode:

• domain: provides a mechanism for storing all user and group accounts in a central, shared, ac-
count repository. The centralized account repository is shared between (security) controllers.

8.2.5. Declare a directory to share

With the Add button, we get:

36You can start this tool from the command line, by typing draksambashare as root.
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A new entry is thus added. It can be modified with the Modify button. Options can be edited, such
as whether the directory is visible to the public, writable or browseable. The share name can not
be modified.

8.2.6. Menu entries

When the list has at least one entry, menu entries can be used.

File|Write conf. Save the current configuration in /etc/samba/smb.conf.

Samba server|Configure. The wizard can be run again with this command.

Samba server|Restart. The server is stopped and restarted with the current configuration files.

Samba Server|Reload. The configuration displayed is reloaded from the current configuration
files.

8.2.7. Printers share

Samba also allows you to share printers.

8.2.8. Samba users

In this tab, you can add users who are allowed to access the shared resources when authentication
is required. You can add users from

8.3. Dostęp do udostępnianych napędów i katalogów NFS
diskdrake --nfs

.

8.3.1. Wprowadzenie

This tool37 allows you to declare some shared directories to be accessible to all users on the ma-
chine. The protocol used for this is NFS which is available on most Linux or Unix systems. The
shared directory will be thus available directly at boot. Shared directories can be also accessible
directly in a single session for a user with tools such as file browsers.

8.3.2. Procedura

Select search servers to obtain a list of servers which share directories.

Click on the > symbol before the server name to display the list of the shared directories and select
the directory you want to access.

37Możesz uruchomić to narzędzie z linii komend, wpisując diskdrake --nfs jako root.
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The button Mount point will be available and you have to specify where to mount the directory.

After choosing the mount point, You can mount it. You can also verify and change some options
with the Options button. After mounting the directory, you can unmount it with the same button.

On accepting the configuration with the Done button, a message will displayed, asking "Do you
want to save the /etc/fstab modifications". This will make the directory available at each boot, if
the network is accessible. The new directory is then available in your file browser, for example in
Dolphin.

8.4. Udostępnianie napędów i katalogów z użyciem NFS
draknfs

8.4.1. Prerequisites

When the wizard38 is launched for the first time, it may display the following message:

The package nfs-utils needs to be installed. Do you want to install it?

After completing the installation, a window with an empty list is displayed.

8.4.2. Main window

A list of directories which are shared is displayed. At this step, the list is empty. The Add button
gives access to a configuration tool.

8.4.3. Edytuj wpis

The configuration tool is labeled "Modify entry". It may be also launched with the Modify button. The
following parameters are available.

8.4.3.1. NFS Directory

Here you can specify which directory is to be shared. The Directory button gives access to a browser
to choose it.

8.4.3.2. Dostęp do komputera

Here you can specify the hosts that are authorized to access the shared directory.

NFS clients may be specified in a number of ways:

single host: a host either by an abbreviated name recognized be the resolver, fully qualified domain
name, or an IP address

netgroups: NIS netgroups may be given as @group.

38You can start this tool from the command line, by typing draknfs as root.
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wildcards: machine names may contain the wildcard characters * and ?. For instance: *.cs.foo.edu
matches all hosts in the domain cs.foo.edu.

IP networks: you can also export directories to all hosts on an IP (sub-)network simultaneously. For
example, either `/255.255.252.0' or `/22' appended to the network base address.

8.4.3.3. Mapowanie ID użytkownika

map root user as anonymous: maps requests from uid/gid 0 to the anonymous uid/gid (root_squ-
ash). The root user from the client cannot read or write to the files on the server which are created
by root on the server itself.

allow real remote root access: turn off root squashing. This option is mainly useful for diskless clients
(no_root_squash).

map all users to anonymous user: maps all uids and gids to the anonymous user (all_squash).
Useful for NFS-exported public FTP directories, news spool directories, etc. The opposite option is
no user UID mapping (no_all_squash), which is the default setting.

anonuid and anongid: explicitly set the uid and gid of the anonymous account.

8.4.3.4. Opcje zaawansowane

Secured Connection: this option requires that requests originate on an internet port less than IP-
PORT_RESERVED (1024). This option is on by default.

Read-Only share: allow either only read or both read and write requests on this NFS volume. The
default is to disallow any request which changes the filesystem. This can also be made explicit by
using this option.

Synchronous access: prevents the NFS server from violating the NFS protocol and to reply to re-
quests before any changes made by these requests have been committed to stable storage (e.g.
disc drive).

Subtree checking: enable subtree checking which can help improve security in some cases, but
can decrease reliability. See exports(5) man page for more details.

8.4.4. Menu entries

So far the list has at least one entry.

8.4.4.1. File|Write conf

Save the current configuration.

8.4.4.2. NFS Server|Restart

The server is stopped and restarted with the current configuration files.

8.4.4.3. NFS Server|Reload

The configuration displayed is reloaded from the current configuration files.

8.5. Dostęp do napędów i katalogów udostępnianych przez WebDAV
diskdrake --dav
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To narzędzie39 można znaleźć w Centrum Sterowania Mageia, pod zakladką Udostępnianie plików,
etykietowane Konfiguracja udziałów WebDAV.

8.5.1. Wprowadzenie

WebDAV [http://en.wikipedia.org/wiki/WebDAV] to protokół umożliwiający zamontowanie katalogu
z serwera WWW lokalnie, tak że wydaje się, że jest lokalnym katalogiem. Obecność oprogramowa-
nia WebDAV jest konieczna na zdalnym serwerze. Konfiguracja serwera WebDAV nie jest celem
tego narzędzia.

8.5.2. Tworzenie nowego wpisu.

Pierwszy ekran tego narzędzia wyświetla skonfigurowane wpisy, jeśli one istnieją, oraz przycisk
Nowy. Aby utworzyć nowy wpis kliknij przycisk. Podaj URL serwera w odpowiedniej dziedzinie na
nowym ekranie.

Then you get a screen with radio buttons to select some actions. Continue with the action Mount
point by clicking OK after selecting the radio button, as the Server is already configured. You can
however correct it, if needed.

Zawartość katalogu zdalnego będzie dostępna poprzez tego punktu montowania.

In the next step, give your user name and password. If you need some other options, you can give
them in the advanced screen.

Opcja Mount pozwala ci natychmiastowo uzyskać dostęp.

After you accepted the configuration with the radio button Done, the first screen is displayed again
and your new mount point is listed. After you choose Quit, you are asked whether or not to save
the modifications in /etc/fstab. Choose this option if you want that the remote directory is available
at each boot. If your configuration is for one-time usage, do not save it.

9. Dyski lokalne

In this screen you can choose between several tools to manage or share your local disks. Click on
a link below to learn more.
Dyski lokalne

1. Sekcja 9.1, „Zarządzanie partycjami dysku”

2. Sekcja 9.2, „Nagrywarka CD/DVD”

3. Sekcja 9.3, „Udostępnianie partycji dysku twardego”

9.1. Zarządzanie partycjami dysku
drakdisk or diskdrake

This tool40 is very powerful, a tiny error or a cat jumping on your keyboard can lead to
losing all data on a partition or even to erasing the entire hard disk. For that reason,

39Można uruchomić to narzędzie z wiersza poleceń, wpisując disdrake --dav jako root.
40You can start this tool from the command line, by typing drakdisk or diskdrake as root.
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you'll see the screen above on top of the tool screen. Click on Exit if you're not sure
you want to continue.

If you have more than one hard disk, you can switch to the hard disk you want to work on by selecting
the correct tab (sda, sdb, sdc etc).

You can choose from many actions to adjust your hard disk to your preferences. Wiping an entire
hard disk, splitting or merging partitions, resizing them or changing the filesystem, formatting or
viewing what is in a partition: it is all possible. The Clear all button at the bottom is to erase the
complete disk, the other buttons become visible on the right after you click on a partition.

If you have an UEFI system, you can see a small partition called "EFI System Partition"
and mounted on /boot/EFI. Never delete it, because it contains all your different opera-
ting systems bootloaders.

If the selected partition is mounted, like in the example below, you cannot choose to resize, format
or delete it. To be able to do that the partition must be unmounted first.

It is only possible to resize a partition on its right side

To change a partition type (change ext3 to ext4 for example) you have to delete the partition and
then re-create it with the new type. The button Create appears when a disk empty part is selected

You can choose a mount point that doesn't exist, it will be created.

Selecting Toggle to expert mode gives some extra available actions, like labeling the partition, as
can be seen in the screenshot below.

9.2. Nagrywarka CD/DVD
diskdrake --removable

This tool 41is found under the tab Local disks in the Mageia Control Center labelled accordingly with
your removable hardware (CD/DVD players and burners and floppy drives only).

Its goal is to define the way your removable disk is mounted.

At the top of the window there is a short description of your hardware and the chosen options to
mount it. Use the menu on the bottom to change them. Check the item to be changed and then
on the OK button.

9.2.1. Punkt montowania

Check this box to change the mount point. The default one is /media/cdrom.

9.2.2. Opcje

Many mount options can be chosen here either directly in the list or via the Advanced submenu.
The main are:

41You can start this tool from the command line, by typing diskdrake --removable as root.
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9.2.2.1. user/nouser

user allows an ordinary user (not root) to mount the removable disk, this option involves noexec,
nosuid and nodev. The user who mounted the disk is the only one who can umount it.

9.3. Udostępnianie partycji dysku twardego
diskdrake --fileshare

Te proste narzędzie 42 pozwala ci, administratorowi aby uprawnić użytkowników do udostępniania
części ich własnych podkatalogów /home z innymi użytkownikami tej samej sieci lokalnej, która
może posiadać komputery działające na systemach Linux lub Windows.

Znajduje się to w Centrum Sterowania Magei, pod sekcją Dysk Lokalny, nazwane "Udostępnij swoje
partycje dysku twardego".

Najpierw odpowiedz na pytanie : " Czy chciałbyś pozwolić użytkownikom na udostępnianie części
z ich katalogów? ", kliknij na Nie udostępniaj jeśli odpowiedź to nie dla wszystkich użytkowników
i kliknij na Własne jeżeli odpowiedź to nie dla niektórych użytkowników i tak dla pozostałych. W
ostatniej opcji użytkownicy którzy są autoryzowani do udostępniania ich katalogów muszą należeć
do grupy fileshare, która jest automatycznie tworzona przez system. Będziesz zapytany o to później.

Kliknij na OK, pojawia się drugi ekran, który pyta cię o wybranie pomiędzy NFS jeśli Linux jest
jedynym systemem operacyjnym w sieci, sprawdź SMB jeżeli sieć zawiera maszyny i z Linuksem
i z Windowsem, a następnie kliknij na OK. Jeżeli jakakolwiek instalacja wymaganego pakietu jest
potrzebna.

Konfiguracja jest kompletna jeśli opcja Własne została wybrana. W tym wypadku kolejny ekran
przeniesie cię aby otworzyć Userdrake. Te narzędzie pozwoli ci dodać autoryzowanych użytkowni-
ków do udostępniania ich katalogów dla grupy fileshare. W sekcju Użytkownicy, kliknij na użytkow-
nika i dodaj go do grupy fileshare, następnie w Edytuj w sekcji Grupy. Sprawdź grupę fileshare i
kliknij na OK. Aby uzyskać więcej informacji o Userdrake, zobacz Sekcja 7.8, „Użytkownicy i grupy”

Kiedy nowy użytkownik dodawany jest do grupy fileshare, musisz rozłączyć i połączyć
ponownie sieć aby modyfikacje zostały dodane do konta.

Od teraz każdy użytkownik należący do grupy fileshare może zaznaczyć w jego managerze plików
katalogi to udostępnienia, jednak nie wszystkie managery plików posiadają taką opcję.

10. Bezpieczeństwo

In this screen you can choose between several security tools. Click on a link below to learn more.
Bezpieczeństwo

1. Sekcja 10.1, „MSEC: bezpieczeństwo systemu i audyt” = Configure system security, permis-
sions and audit

2. Sekcja 10.2, „Konfiguracja osobistej zapory sieciowej”

3. Sekcja 10.3, „Konfiguracja uwierzytelniania dla narzędzi Magei”

4. Sekcja 10.4, „Zaawansowana konfiguracja interfejsów sieciowych i zapory”

42Możesz uruchomić to narzędzie z linii poleceń, wpisując diskdrake -- fileshare jako root.
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5. Sekcja 10.5, „Kontrola rodzicielska”

10.1. MSEC: bezpieczeństwo systemu i audyt
msecgui

10.1.1. Presentation

msecgui43 is a graphic user interface for msec that allows to configure your system security accor-
ding to two approaches:

• It sets the system behaviour, msec imposes modifications to the system to make it more secure.

• It carries on periodic checks automatically on the system in order to warn you if something seems
dangerous.

msec uses the concept of "security levels" which are intended to configure a set of system permis-
sions, which can be audited for changes or enforcement. Several of them are proposed by Mageia,
but you can define your own customised security levels.

10.1.2. Overview tab

See the screenshot above

The first tab takes up the list of the different security tools with a button on the right side to configure
them:

• Firewall, also found in the MCC / Security / Set up your personal firewall

• Updates, also found in MCC / Software Management / Update your system

• msec itself with some information:

– enabled or not

– the configured Base security level

– the date of the last Periodic checks and a button to see a detailed report and another button
to execute the checks just now.

10.1.3. Security settings tab

A click on the second tab or on the Security Configure button leads to the same screen shown below.

10.1.3.1. Basic security tab

Security levels:

After having checked the box Enable MSEC tool, this tab allows you by a double click to choose
the security level that appears then in bold. If the box is not checked, the level « none » is applied.
The following levels are available:

1. Level none. This level is intended if you do not want to use msec to control system security, and
prefer tuning it on your own. It disables all security checks and puts no restrictions or constraints
on system configuration and settings. Please use this level only if you are knowing what you
are doing, as it would leave your system vulnerable to attack.

43You can start this tool from the command line, by typing msecgui as root.
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2. Level standard. This is the default configuration when installed and is intended for casual users.
It constrains several system settings and executes daily security checks which detect changes
in system files, system accounts, and vulnerable directory permissions. (This level is similar to
levels 2 and 3 from past msec versions).

3. Level secure. This level is intended when you want to ensure your system is secure, yet usable.
It further restricts system permissions and executes more periodic checks. Moreover, access
to the system is more restricted. (This level is similar to levels 4 (High) and 5 (Paranoid) from
old msec versions).

4. Besides those levels, different task-oriented security are also provided, such as the fileserver ,
webserver and netbook levels. Such levels attempt to pre-configure system security according
to the most common use cases.

5. The last two levels called audit_daily  and audit_weekly are not really security levels but rather
tools for periodic checks only.

These levels are saved in etc/security/msec/level.<levelname>. You can define your own
customised security levels, saving them into specific files called level.<levelname>, placed
into the folder etc/security/msec/. This function is intended for power users which require a
customised or more secure system configuration.

Keep in mind that user-modified parameters take precedence over default level settings.

Security alerts:

If you check the box Send security alerts by email to:, the security alerts generated by msec are
going to be sent by local e-mail to the security administrator named in the nearby field. You can
fill either a local user or a complete e-mail address (the local e-mail and the e-mail manager must
be set accordingly). At last, you can receive the security alerts directly on your desktop. Check the
relevant box to enable it.

It is strongly advisable to enable the security alerts option in order to immediately inform
the security administrator of possible security problems. If not, the administrator will
have to regularly check the logs files available in /var/log/security.

Security options:

Creating a customised level is not the only way to customise the computer security, it is also possible
to use the tabs presented here after to change any option you want. Current configuration for msec
is stored in /etc/security/msec/security.conf. This file contains the current security level
name and the list of all the modifications done to the options.

10.1.3.2. System security tab

This tab displays all the security options on the left side column, a description in the centre column,
and their current values on the right side column.

To modify an option, double click on it and a new window appears (see screenshot below). It displays
the option name, a short description, the actual and default values, and a drop down list where the
new value can be selected. Click on the OK button to validate the choice.

51



Do not forget when leaving msecgui to save definitively your configuration using the
menu File -> Save the configuration. If you have changed the settings, msecgui allows
you to preview the changes before saving them.

10.1.3.3. Bezpieczeństwo sieci

This tab displays all the network options and works like the previous tab

10.1.3.4. Periodic checks tab

Periodic checks aim to inform the security administrator by means of security alerts of all situations
msec thinks potentially dangerous.

This tab displays all the periodic checks done by msec and their frequency if the box Enable periodic
security checks is checked. Changes are done like in the previous tabs.

10.1.3.5. Exceptions tab

Sometimes alert messages are due to well known and wanted situations. In these cases they are
useless and wasted time for the administrator. This tab allows you to create as many exceptions
as you want to avoid unwanted alert messages. It is obviously empty at the first msec start. The
screenshot below shows four exceptions.

To create an exception, click on the Add a rule button

Select the wanted periodic check in the drop down list called Check and then, enter the Exception
in the text area. Adding an exception is obviously not definitive, you can either delete it using the
Delete button of the Exceptions tab or modify it with a double clicK.

10.1.3.6. Prawa dostępu

This tab is intended for file and directory permissions checking and enforcement.

Like for the security, msec owns different permissions levels (standard, secure, ..), they are enabled
accordingly with the chosen security level. You can create your own customised permissions levels,
saving them into specific files called perm.<levelname>  placed into the folder etc/securi-
ty/msec/ . This function is intended for power users which require a customised configuration. It
is also possible to use the tab presented here after to change any permission you want. Current
configuration is stored in /etc/security/msec/perms.conf. This file contains the list of all
the modifications done to the permissions.

Default permissions are visible as a list of rules (a rule per line). You can see on the left side, the
file or folder concerned by the rule, then the owner, then the group and then the permissions given
by the rule. If, for a given rule:

• the box Enforce is not checked, msec only checks if the defined permissions for this rule are
respected and sends an alert message if not, but does not change anything.

• the box Enforce is checked, then msec will rule the permissions respect at the first periodic check
and overwrite the permissions.
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For this to work, the option CHECK_PERMS in the Periodic check tab must be con-
figured accordingly.

To create a new rule, click on the Add a rule button and fill the fields as shown in the example below.
The joker * is allowed in the File field. “current” means no modification.

Click on the OK button to validate the choice and do not forget when leaving to save definitively
your configuration using the menu File -> Save the configuration. If you have changed the settings,
msecgui allows you to preview the changes before saving them.

It is also possible to create or modify the rules by editing the configuration file /etc/
security/msec/perms.conf.

Changes in the Permission tab (or directly in the configuration file) are taken into acco-
unt at the first periodic check (see the option CHECK_PERMS in the Periodic checks
tab). If you want them to be taken immediately into account, use the msecperms com-
mand in a console with root rights. You can use before, the msecperms -p command to
know the permissions that will be changed by msecperms.

Do not forget that if you modify the permissions in a console or in a file manager, for
a file where the box Enforce is checked in the Permissions tab , msecgui will write
the old permissions back after a while, accordingly to the configuration of the options
CHECK_PERMS and CHECK_PERMS_ENFORCE in the Periodic Checks tab .

10.2. Konfiguracja osobistej zapory sieciowej
drakfirewall

This tool44 is found under the Security tab in the Mageia Control Center labelled "Set up your perso-
nal firewall". It is the same tool in the first tab of "Configure system security, permissions and audit".

A basic firewall is installed by default with Mageia. All the incoming connections from the outside
are blocked if they aren't authorised. In the first screen above, you can select the services for which
outside connection attempts are accepted. For your security, uncheck the first box - Everything (no
firewall) - unless you want to disable the firewall, and only check the needed services.

It is possible to manually enter the port numbers to open. Click on Advanced and a new window is
opened. In the field Other ports, enter the needed ports following these examples :

80/tcp : open the port 80 tcp protocol

24000:24010/udp : open all the ports from 24000 to 24010 udp protocol

The listed ports should be separated by a space.

If the box Log firewall messages in system logs is checked, the firewall messages will be saved
in system logs

44You can start this tool from the command line, by typing drakfirewall as root.
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If you don't host specific services (web or mail server, file sharing, ...) it is completely
possible to have nothing checked at all, it is even recommended, it won't prevent you
from connecting to the internet.

The next screen deals with the Interactive Firewall options. These feature allow you to be warned of
connection attempts if at least the first box Use Interactive Firewall is checked. Check the second
box to be warned if the ports are scanned (in order to find a failure somewhere and enter your
machine). Each box from the third one onwards corresponds to a port you opened in the two first
screens; in the screenshot below, there are two such boxes: SSH server and 80:150/tcp. Check
them to be warned each time a connection is attempted on those ports.

These warning are given by alert popups through the network applet.

In the last screen, choose which network interfaces are connected to the Internet and must be
protected. Once the OK button is clicked, the necessary packages are downloaded.

If you don't know what to choose, have a look in MCC tab Network & Internet, icon Set
up a new network interface.

10.3. Konfiguracja uwierzytelniania dla narzędzi Magei
draksec

This tool45is present in the Mageia Control Center under the tab Security

It allows to give the regular users the needed rights to accomplish tasks usually done by the ad-
ministrator.

Click on the little arrow before the item you want to drop down:

Most of the tools available in the Mageia Control Center are displayed in the left side of the window
(see the screenshot above) and for each tool, a drop down list on the right side gives the choice
between:

• Default: The launch mode depends on the chosen security level. See in the same MCC tab, the
tool "Configure system security, permissions and audit".

• User password: The user password is asked before the tool launching.

• Administrator password: The root password is asked before the tool launching

• No password: The tool is launched without asking any password.

10.4. Zaawansowana konfiguracja interfejsów sieciowych i zapory
drakinvictus

45You can start this tool from the command line, by typing draksec as root.
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This page hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Doc team. [https://wiki.mageia.org/en/Documentation_team] Thanking you in advance.

You can start this tool from the command line, by typing drakinvictus as root.

10.5. Kontrola rodzicielska
drakguard

This tool46 is found in the Mageia Control Center, under the Security tab, labelled Parental Control.
If you don't see this label, you have to install the drakguard package (not installed by default).

10.5.1. Presentation

Drakguard is an easy way to set up parental controls on your computer to restrict who can do what,
and at which times of day. Drakguard has three useful capabilities:

• It restricts web access to named users to set times of day. It does this by controlling the shorewall
firewall built into Mageia.

• It blocks execution of particular commands by named users so these users can only execute
what you accept them to execute.

• It restricts access to websites, both manually defined through blacklists/whitelists, but also dyna-
mically based on the content of the website. To achieve this Drakguard uses the leading open-
source parental control blocker DansGuardian.

10.5.2. Configuring Parental controls

If your computer contains hard drive partitions that are formatted in Ext2, Ext3, or Re-
iserFS format you will see a pop up offering to configure ACL on your partitions. ACL
stands for Access Control Lists, and is a Linux kernel feature that allows access to indi-
vidual files to be restricted to named users. ACL is built into Ext4 and Btrfs file systems,
but must be enabled by an option in Ext2, Ext3, or Reiserfs partitions. If you select 'Yes'
to this prompt drakguard will configure all your partitions to support ACL, and will then
suggest you reboot.

Enable parental control: If checked, the parental control is enabled and the access to Block pro-
grams tab is opened.

Block all network traffic: If checked, all the websites are blocked, except the ones in the whitelist
tab. Otherwise, all the websites are allowed, except the ones in the blacklist tab.

User access: Users on the left hand side will have their access restricted according to the rules
you define. Users on the right hand side have unrestricted access so adult users of the computer
are not inconvenienced. Select a user in the left hand side and click on Add to add him/her as an
allowed user. Select an user in the right hand side and click on Remove to remove him/her from
the allowed users.

Time control: If checked, internet access is allowed with restrictions between the Start time and End
time. It is totally blocked outside these time window.

10.5.2.1. Blacklist/Whitelist tab

Enter the website URL in the first field at the top and click on the Add button.

46You can start this tool from the command line, by typing drakguard as root.
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10.5.2.2. Block Programs Tab

Block Defined Applications: Enables the use of ACL to restrict access to specific applications. Insert
the path to the applications you wish to block.

Unblock Users list: Users listed on the right hand side will not be subject to acl blocking.

11. Uruchamianie

In this screen you can choose between several tools to configure your boot steps. Click on a link
below to learn more.
Konfiguracja etapów uruchamiania

1. Sekcja 11.1, „Konfiguracja automatycznego logowania”

2. Sekcja 11.2, „Konfiguracja sposobu uruchamiania”

3. Sekcja 11.3, „Konfiguracja menedżera wyświetlania”

11.1. Konfiguracja automatycznego logowania
drakautologin

This tool47 allows you to automatically login the same user, in her/his desktop environment, without
asking for any password. It's called autologin. This is generally a good idea when there is only one
user like to be using the machine.

It is found under the Boot tab in the Mageia Control Center labelled "Set up autologin to automa-
tically log in".

The interface buttons are pretty obvious:

Check Launch the graphical environment when your system starts, if you want X Window System to
be executed after the boot. If not, the system will start in text mode. Nevertheless, it will be possible
to launch the graphic interface manually. This can be done by launching the command 'startx' or
'systemctl start dm'.

If the first box is checked, two other options are available, check either No, I don't want autologin,
if you want the system to continue to ask for which user to connect (and password) or check Yes, I
want autologin with this (user, desktop), if needed. In this case, you also need to supply the Default
username and the Default desktop.

11.2. Konfiguracja sposobu uruchamiania
drakboot

If you are using a UEFI system instead of BIOS, the user interface is slightly different as the boot
device is obviously the EFI system Partition (ESP).

This tool48 allows you to configure the boot options (choice of the bootloader, set a password, the
default boot, etc.)

It is found under the Boot tab in the Mageia Control Center labeled "Set up boot system".

47You can start this tool from the command line, by typing drakautologin as root.
48You can start this tool from the command line, by typing drakboot as root.
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Don't use this tool if you don't know exactly what you are doing. Changing some settings
may prevent your machine from booting again !

In the first part, called Bootloader, it is possible if using BIOS, to choose which Bootloader to use,
Grub, Grub2 or Lilo, and with a graphical or a text menu. It is just a question of taste, there are no
other consequences. You can also set the Boot device, don't change anything here unless you are
an expert. The boot device is where the bootloader is installed and any modification can prevent
your machine from booting.

In a UEFI system, the bootloader is Grub2-efi and is installed in /boot/EFI partition. This FAT32
formatted partition is common to all operating systems installed.

In the second part, called Main options, you can set the Delay before booting default image, in
seconds. During this delay, Grub or Lilo will display the list of available operating systems, prompting
you to make your choice. If no selection is made, the bootloader will boot the default one once the
delay elapses.

In the third and last part, called Security, it is possible to set a password for the bootloader. This
means a username and password will be asked at the boot time to select a booting entry or change
settings. The username is "root" and the password is the one chosen here.

The Advanced button gives some extra options.

Enable ACPI:

ACPI (Advanced Configuration and Power Interface) is a standard for the power management. It
can save energy by stopping unused devices, this was the method used before APM. Check this
box if your hardware is ACPI compatible.

Enable SMP:

SMP stands for Symmetric Multi Processors, it's an architecture for multicore processors.

If you have a processor with HyperThreading, Mageia will see it as a dual processor
and enable SMP.

Enable APIC and Enable Local APIC:

APIC stands for Advanced Programmable Interrupt Controller. There are two components in the
Intel APIC system, the local APIC (LAPIC) and the I/O APIC. The latter one routes the interrupts
it receives from peripheral buses to one or more local APICs that are in the processor. It is really
useful for multi-processor systems. Some computers have problems with the APIC system which
can cause freezes or incorrect device detection (error message "spurious 8259A interrupt: IRQ7").
In this case, disable APIC and/or Local APIC.

The Next screen differs depending on which boot loader you chose.

• You have Grub Legacy or Lilo:

In this case, you can see the list of all the available entries at boot time. The default one is
asterisked. To change the order of the menu entries, click on the up or down arrows to move the
selected item. If you click on the Add or Modify buttons, a new window appears to add a new
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entry in the bootloader menu or to modify an existing one. You need to be familiar with Lilo or
Grub to be able to use these tools.

The Label field is freeform, write here what you want to be displayed in the menu. It matches the
Grub command "title". For example: Mageia3.

The Image field contains the kernel name. It matches the Grub command "kernel". For example /
boot/vmlinuz.

The Root field contains the device name where the kernel is stored. It matches the Grub command
"root". For example (hd0,1).

The Append field contains the options to be given to the kernel at boot time.

If the box Default is checked, Grub will boot this entry by default.

In the extra screen called Advanced, it is possible to choose the Video mode, an initrd file and a
network profile, see Sekcja 6.6, „Zarządzanie profilami sieciowymi”, in the drop-down lists.

• You have Grub2 or Grub2-efi (boot loaders used by default respectively in Legacy mode and
UEFI mode):

In this case, the drop-down list labelled Default displays all the available entries; click on the one
wanted as the default one.

The Append field contains the options to be given to the kernel at boot time.

If you have other operating systems installed, Mageia attempts to add them to your Mageia boot
menu. If you don't want this behaviour, uncheck the box Probe Foreign OS

In the extra screen called Advanced, it is possible to choose the Video mode. If you don't want
a bootable Mageia, but to chain load it from another OS, check the box Do not touch ESP or
MBR and accept the warning.

Not installing on ESP or MBR means that the installation is not bootable unless chain
loaded from another OS.

To set many other parameters, you can use the tool named Grub Customizer, available in the
Mageia repositories (see below).

11.3. Konfiguracja menedżera wyświetlania
drakedm

Here49 you can choose which display manager to use to log into your desktop environment. Only
the ones available on your system will be shown.

Most users will only notice that the provided login screens look different. However, there are diffe-
rences in supported features, too. LXDM is a lightweight display manager, SDDM and GDM have
more extras.

49You can start this tool from the command line, by typing drakedm as root.
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12. Other Mageia Tools
There are more Mageia tools than those that can be started in the Mageia Control Center. Click on
a link below to learn more, or continue reading the next pages.

1. Sekcja 12.1, „Narzędzie raportowania błędów”drakbug
2. Sekcja 12.2, „Collect Logs and System Information for Bug Reports”drakbug_report
3. Sekcja 12.3, „Display Available NFS And SMB Shares”TO BE WRITTEN
4. Sekcja 12.4, „Display Your PCI, USB and PCMCIA Information”

5. And more tools?

12.1. Narzędzie raportowania błędów
drakbug

Usually, this tool50 starts automatically when a Mageia tool crashes. However, it is also possible
that, after filing a bug report, you are asked to start this tool to check some of the information it
gives, and then provide that in that existing bug report.

If a new bug report needs to be filed and you are not used to doing that, then please read How
to report a bug report properly [https://wiki.mageia.org/en/How_to_report_a_bug_properly] before
clicking on the "Report" button.

In case the bug has already been filed by someone else (the error message that drakbug gave will
be the same, then), it is useful to add a comment to that existing report that you saw the bug, too.

12.2. Collect Logs and System Information for Bug Reports
drakbug_report

This tool51 can only be started and used on the command line.

It is advised to write the output of this command to a file, for instance by doing drakbug_report >
drakbugreport.txt, but make sure you have enough disk space first: the file can easily be several
GBs large.

The output is far too large to attach to a bug report without first removing the unneeded
parts.

This command collects the following information on your system:

• lspci

• pci_devices

• dmidecode

• fdisk

• scsi

• /sys/bus/scsi/devices

50Można uruchomić to narzędzie z wiersza poleceń, wpisując drakbug.
51You can start this tool from the command line, by typing drakbug_report as root.
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• lsmod

• cmdline

• pcmcia: stab

• usb

• partitions

• cpuinfo

• syslog

• Xorg.log

• monitor_full_edid

• stage1.log

• ddebug.log

• install.log

• fstab

• modprobe.conf

• lilo.conf

• grub: menu.lst

• grub: install.sh

• grub: device.map

• xorg.conf

• urpmi.cfg

• modprobe.preload

• sysconfig/i18n

• /proc/iomem

• /proc/ioport

• mageia version

• rpm -qa

• df

At the time this help page was written, the "syslog" part of this command's output was
empty, because this tool had not yet been adjusted to our switch to systemd. If it is still
empty, you can retrieve the "syslog" by doing (as root)  journalctl -a > journalctl.txt. If
you don't have a lot of diskspace, you can, for instance, take the last 5000 lines of the
log instead with: journalctl -a | tail -n5000 > journalctl5000.txt.

12.3. Display Available NFS And SMB Shares
lsnetdrake

This tool 52 can only be started and used on the command line.

This page hasn't been written yet for lack of resources. If you think you can write this help, please
contact  the Documentation team. [https://wiki.mageia.org/en/Documentation_team] Thanking you
in advance.

52You can start this tool from the command line, by typing lsnetdrake.
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12.4. Display Your PCI, USB and PCMCIA Information
lspcidrake

This tool 53 can only be started and used on the command line. It will give some more information
if used under root.

lspcidrake gives the list of all the connected devices to the computer (USB, PCI and PCMCIA) and
the used drivers. It needs the ldetect and ldetect-lst packages to work.

With the -v option, lspcidrake adds the vendor and device identifications.

lspcidrake often generates very long lists, so, to find an information, it is often used in a pipeline
with the grep command, like in these examples:

Information about the graphic card;

lspcidrake | grep VGA

Information about the network

lspcidrake | grep -i network

-i to ignore case distinctions.

In this screenshot below, you can see the action of the -v option for lspcidrake and the -i option
for grep.

There is another tool that gives information about the hardware, it is called dmidecode (under root)

53You can start this tool from the command line, by typing lspcidrake.
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